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When you look at the progress made in the field of
photography from its humble beginnings in 1839

to the ever-changing digital technology of today, you
can’t help but be amazed. Today, the predominant
method of image capture is digital, cameras are smaller
than ever, the price of good equipment has dropped dra-
matically, and our cameras can now make many impor-
tant decisions for us. As a result, more and more novices
are creating better and better images.

Of course, even leaps and bounds in technology will
not replace a solid knowledge of the art and science of
photography. An understanding of how aperture and
shutter speed changes affect exposure, how highlight
and shadow can be used to sculpt your subject’s face, or
how to arrange the elements of your image to hold the

viewer’s attention and evoke an emotional response
requires the photographer’s input, his personal artistic
vision and creative approach. While technology might
help us create better images, only the professional pho-
tographer can create images that clients will pay for.

This book provides the technical foundation you need
to make the transition to a career as a professional pho-
tographer. With information on cameras and lenses,
lighting and exposure, posing and composition, and
post-capture essentials, plus an appendix on the impor-
tance of becoming a Certified Professional Photog-
rapher, you’ll learn the rules that govern good image
capture and gain the solid footing you need to embark
on a successful career.
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Digital imaging is the predominant capture method used by photogra-
phers today. Still, a discussion of film photography has its place in this

book (after all, some photographers still swear by its use). Before we move
on to discuss digital cameras and the basics of digital capture, then, we’ll pay
homage to film capture and take a look at the film cameras traditionally used
by professional photographers. 

Film
Film is the light-sensitive plastic substance used in a camera to record a pho-
tographic image. An image is created when light reacts with the silver halide
crystals on the film. The following are some characteristics to keep in mind
when selecting film.

Negative vs. Positive. Film is divided into two types: negative (print) and
positive (chrome, slide) film. Film is available in several sizes and formats
with the most popular being 35mm, 120/220, and 4x5-inch sheet film.

Negative film produces a negative upon exposure to light through a cam-
era. (In other words, the tones recorded are opposite those that we actually
see in the subject with our eyes.) This type of film is also referred to as print
film because you generally need to make a print from the negative to ade-

quately see and enjoy the image. There are a wide variety
of color and black & white negative films on the market. 

When a positive, or “transparency,” film is used, on
the other hand, the positive image is produced right on

the film in the camera. The resulting images can be viewed via a projector,
or the images can be printed onto photographic paper. Most transparency
films are made for color photography.

Color Balance. Different types of film are produced to record colors
accurately under different types of lighting. The types of lighting are differ-
entiated based on their color temperatures (see sidebar). There are two basic
color balances available. Daylight film, balanced for use with light sources of
about 5500 degrees Kelvin, produces accurate color when the scene is illu-
minated with normal daylight or electronic flash. Tungsten film (also known
as Type A) is balanced for use with light sources with a color temperature of
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3200 to 3400 degrees Kelvin. It produces acceptable color when your sub-
ject is illuminated with ordinary household bulbs. For more on this topic,
see chapter 4.

Black & White Film. When selecting a black & white film, color temper-
ature is irrelevant since the film records only shades of gray. Black & white
film comes in a variety of film speeds up to ISO 3200 (see pages 10–11).
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Photographic images are created using a
variety of light sources—from sunlight (top
left), to studio strobe lighting (top right),
to mixed lighting (left). When accurate col-
ors are desired, the photographer must
select a film (or choose a digital camera
white balance setting) that matches the
lighting. Photographs by Lisa Farnholz (top
left), Rob Ledwedge (top right), and Michael
Ayers (left).

35MM FILM
“35mm film” refers to the actual size of
the film frame itself. It is approximate-
ly 1x11/2 inches.

 



Over the years, Kodak and other man-
ufacturers have made several specialty
emulsions of black & white film for spe-
cific photographic applications. Black
& white film was the only option for
photographers until the very first color
transparency films appeared in the
1940s. Color negative film did not
become readily available until the late
1960s. 

Different black & white films
record colors in different ways. Pan-
chromatic film is sensitive to all of the
colors in the visible spectrum, making it
the most commonly used type of black
& white film. Because this type of film

is slightly more sensitive to blues than other colors, however, blue tones in
a scene (such as the sky) can record lighter than expected. This can be cor-
rected using filters (see chapter 5). Orthochromatic (ortho) film is sensitive
to the blue and green but not the red wavelengths of the visible spectrum.

IMAGE CAPTURE 9

COLOR TEMPERATURE
The light that we see is comprised of seven distinct colors: red, orange, yellow, green,
blue, indigo, and violet. The human eye does a good job of balancing these colors, so
colors look the same to us whether they are under reddish light (like at sunset), yel-
lowish light (like a household lamp), or greenish light (like most fluourescents). Film
and digital image sensors, on the other hand, do not adapt as readily. 

Therefore, it is important to evaluate the color of the light before shooting to
ensure accurate color results. The color of a light source is described as its color 
temperature.

“White” light is the starting point for color temperature and measures about 5500
degrees Kelvin. Therefore, daylight film is balanced to precisely this color tempera-
ture. As the sun rises or sets, the color of its light gets warmer, which is noted as a
lower temperature (as unintuitive as that may be!). Temperatures higher than 5500
degrees Kelvin indicate a light balance that is cooler, or more blue. 

When the color balance of the medium used to capture the image matches the
color temperature of the light, the colors in the image will be rendered as the eye sees
them. 

Black & white portraits have a clean, simple
feel that makes them timeless. Photograph
by Patrick Rice.

 



It is mainly used for copy and graphic arts work. Lithographic (litho) film is
a type of very high-contrast film used in the printing industry.

Chromogenic black & white film is another popular choice for photogra-
phers. Because it is composed of dyes rather than silver, it can be developed
and printed in the same chemistry used to process color negative film. Today,
this type of processing is typically cheaper and more readily available than
traditional black & white processing (see page 12).

Anti-Halation. Many films are made with an anti-halation layer. An anti-
halation layer is a light-absorbing layer between the photographic emulsion
and the film backing. It is used to prevent stray light from reaching the light-
sensitive area of the film. 

Film Speed. The ISO value of a film (also called the film speed) describes
how sensitive the film is to light. Each full change in the ISO either halves
or doubles the light sensitivity of the film (i.e., a film with an ISO rating of
400 is twice as sensitive to light as a film with an ISO of 200).
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Black & white is a popular choice for images
ranging from portraits to landscapes. Photo-
graphs by Rick Ferro (left) and Rob Led-
wedge (right).

DX CODING
Many films, especially 35mm, have what
is called DX coding to help the photog-
rapher avoid mistakes when setting the
ISO on their camera. This coding
instantly tells the camera the speed of
the film being loaded. 

 



Films with high ISO values (called “fast” films) require less light to create
an acceptable exposure. However, they also produce more grain (a speckled
pattern that appears in the negative and the resultant print) and a reduction
in sharpness, saturation, detail, and color accuracy. These films are best in
low-light situations and when you need to stop the action in a scene.

Films with low ISO values (called “slow” films) require more light to pro-
duce a good exposure, but they also produce images with less grain and bet-
ter sharpness. Slow films are good for big enlargements because they have
less grain.

Reciprocity. Though the specifics of ensuring a good exposure won’t be
covered until chapter 3, it is important to take note of a phenomenon called
reciprocity in this section. Film reciprocity refers to the reduction in effec-
tive film speed when using very long exposures—usually one second or
longer. This reduction in film speed results in underexposed images unless
you compensate for it by increasing your exposure. The longer the exposure
of the image, the more you will need to increase your exposures. With all
long exposure photos, you should bracket your exposures to ensure accept-
able results. 

Another consideration when producing very long exposures is the in-
crease in image contrast due to the fact that the increased exposure time has
more impact on the highlights in the scene than on the shadow areas. This
increase in contrast is usually dealt with in the printing process.

The reciprocity effect is easier to manage with black & white film than
with color film. With color film, each color layer will respond differently to
very long exposures, and the entire color balance of the image will be affect-
ed. This color shift can be prevented by using the proper color correction
(CC) filter over the camera lens at the time the exposure is made (see chap-
ter 5).

Storage. Film should be stored in a cool and dry place away from direct
sunlight. All film has an expiration date stamped on the box, but storing film
in the refrigerator will render it usable long past the expiration date (and
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In low-light situations, higher ISOs are often used—especially when flash cannot be used or
would be impractical. Photographs by Patrick Rice (left) and Michael Ayers (above).

 



storing it in the freezer will extend its life indefinitely). I visited the Eastman
Kodak facility in Rochester, New York, and had the opportunity to walk into
one of the huge film freezers. I was able to get some “expired” films that
were no longer in production. Each exposed and processed perfectly. (Note:
Cooled or frozen films must be allowed to reach the ambient temperature
before shooting to prevent excess humidity in the camera.)

Processing. While it goes beyond the scope of this book to provide com-
plete instruction on developing film and printing images, the following is a
basic overview. For more detailed information, you may wish to consult a
specialized volume such as Into Your Darkroom Step-by-Step by Dennis P.
Curtin (Amherst Media, 1991). 

The first step in developing film is
to determine the developer that will
be used. For color negative film, this
will generally be C41 chemistry. For
black & white negative film, it will
typically be an all-purpose black &
white developer. Transparency film is
generally processed in E6 chemistry.
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COLOR LABS: A BRIEF HISTORY
Until the late 1960s, photographers either developed and printed their own pictures or
sent them to Eastman Kodak for printing. Because of the complicated process required
to produce color prints, however, some entrepreneurs soon discovered there was a mar-
ket for photo-finishing services among both professional and amateur photographers.
This is how the color processing lab was born. Before long, department stores and drug
stores recognized the growing popularity of color photography and began developing and
printing color film for consumers. Today, the revolution continues, and most of these
establishments are now printing from digital files.

Whether they are film or digital, images
must be carefully processed and printed to
ensure professional-quality results. Photo-
graphs by Barbara Rice.

 



Once selected, the developer’s reference chart for the specific film can be
used to determine the proper development time and temperature. 

Next, the exposed film is opened in a darkroom or film changing bag and
loaded onto a film developing reel. This reel is then placed into the develop-
ing tank, and the light-proof lid is closed. The film developer is added to the
tank and left in for the duration of time specified. During this process, the
tank must be agitated at regular intervals to move the processing fluids over
the photographic film. 

After the developing time is complete, the developer is dumped out of the
tank and stop bath is poured in. Generally, this is left in the tank for 30 sec-
onds and agitated continuously. 

The stop bath is then poured out and the fixer (a chemical solution that
makes the emulsion of film or paper no longer sensitive to light) is added.
The active ingredient in the fixes, sodium hyposulfate or sodium thiosulfate,
dissolves the unused and unexposed silver halide crystals. After film or paper
is treated with a fixing agent, only the developed silver image will remain. 

At this point, a washing aid solution can be used to shorten the amount
of time needed for washing the film. After this, the film is washed in the tank
using a continuous water source from a faucet or hose. (Another optional
but recommended step is to treat the film with a wetting agent like Kodak
Photo-Flo. Photo-Flo is good at preventing water spots on your film.) 

Finally, the film reel is removed from the tank. The film is unwound from
the reel and hung to dry. A film drying cabinet is very helpful in speeding up
this process and keeping the film away from airborne dust while it is still wet. 

Photographers have numerous ways to manipulate the processing of their
film for optimum results. For example, an activator can be added to improve
the development process. Developing time can be changed for specific pur-
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While many enhancements can be made to
images in the traditional darkroom, the
advent of digital imaging has dramatically
increased the creative options—and de-
creased the time required to create them.
Photographs courtesy of Visualizations
Photography.

 



poses. For instance, overdevelopment (allowing the film to develop for
longer than recommended) can be used as a method to get better results
from images you know were underexposed at the time of shooting.

Digital Images from Film. If you’ve captured a film image that you wish
to archive as a digital file (or to digitally enhance), then you can create a
high-resolution scan of your film image, be it a print or a negative. For more
information on the steps required to achieve a good scan, see The Practical
Guide to Digital Imaging by Michelle Perkins (Amherst Media, 2005).

Film Cameras
35mm Cameras: Point & Shoot vs. SLR. 35mm cameras are the most
common camera format, accepting 35mm film in print and slide formats. 

Fixed-lens 35mm cameras, called point & shoot cameras, come equipped
with either a single focal length lens (usually a moderate wide-angle lens) or
a zoom lens. These are highly portable and can be easily carried to almost
any event. While these cameras produce relatively good images, the single-
lens reflex camera (SLR) provides serious amateurs and professionals with
the shooting versatility they need to get the best-possible pictures.

Using an SLR offers several advantages. First, the subject is viewed via a
mirror that is situated behind the lens. When the exposure is made, the mir-
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Whether you shot the image on film or cap-
tured it digitally, image-editing software
can help you to produce the flawless look
today’s clients demand. Photograph by
Monte Zucker.

 



ror flips up and out of the way. As a result, the image is both previewed and
shot through the same lens, eliminating potential framing problems that can
occur with other preview methods. SLRs also allow for the use of a wide vari-
ety of lenses, allowing for different image effects. Finally, unlike most point
& shoots, using an SLR allows you to manually set the camera’s exposure
and focus (in addition to selecting from the numerous other shooting modes
available on recent models). 

35mm cameras have really changed over the years. Starting with the very
simple and dependable 35mm cameras of the 1950s and 1960s, photogra-
phers received excellent results with this small-format film source. In the
1970s, 35mm SLR camera manufacturers began to introduce better meter-
ing systems and automatic functions (including autoexposure, automatic
metering, automatic film loading, and early autofocus). 

The next major breakthrough was the invention of true autofocus tech-
nology. While the first autofocus cameras would not always precisely focus
the camera, these focusing systems continue to improve. Today’s 35mm
SLRs are very sophisticated, and their focusing systems are very accurate. In
fact, the autofocus on most cameras is probably better than the photograph-
er’s own vision! For more on autofocus, see page 43.

View Cameras. View cameras, while less often used today than in years
past, offer some appealing features. First, the large size of the film utilized
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Knowing how to use the manual focus and
exposure settings on your camera greatly
increases your creative potential. Photo-
graph by Dennis Orchard. 

 



by a view camera allows for outstanding quality in big enlargements. Some
view cameras can be fitted with a Polaroid film back, a 120-film back, or a
4x5-, 5x7-, or 8x10-inch sheet film holder. Today, we even have digital backs
for view cameras. 

Additionally, view cameras feature swings and tilts, meaning that the lens
and film plane can be moved independently from each other—up, down,
sideways, and back and forth. This allows the photographer to increase or
decrease the depth of field, alter perspective, and reduce subject distortion.
For example, when recording a tall building, a photographer with any other
type of camera will need to tilt the camera up toward the building. As a
result, the film plane will be at an angle to the plane of the building. Because
the film is closer to the building at the bottom than at the top, the parallel
vertical lines of the building will converge in the resulting image, narrowing
toward the top of the frame. With a view camera, the film plane can be kept
perfectly parallel to the building, while only the lens is tilted up to frame the
intended shot. As a result, view cameras can maintain nice straight vertical
lines in a way that other cameras cannot.

When using a view camera, the photographer previews the image on a
ground glass, which shows the subject upside down and backwards. Many
view cameras are fitted with a focusing cloth, a black piece of fabric that cov-
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When the film plane of a camera is posi-
tioned at an angle to the subject, distortion
is created. This is particularly evident in
architectural photos, where the parallel
lines of the actual building appear to con-
verge in the image. This can be avoided with
a view camera by using the camera’s swings
and tilts to keep the film plane parallel to
the subject. As these images demonstrate,
however, this distortion can actually be
used effectively to create strong diagonal
lines and powerful compositions. Photo-
graphs by Drew Smith.

 



ers the back of the camera and the photographer’s head to block out light
and make it easier for the photographer to sharply focus the picture on the
ground glass.

Medium Format Cameras. Medium format cameras generally accept
21/4-inch film in 120 or 220 rolls. While the 21/4-inch film size is a fixed
dimension, different models of medium format cameras produce different
frame sizes—21/4x21/4 (6x6cm), 21/4x23/4 (6x7cm), 21/4x15/8-inch (6x4.5cm),
and other sizes with panoramic cameras. Medium format cameras were the
cameras of choice for wedding and portrait photographers before the digital
age. Today, you can get digital backs for medium format cameras with sen-
sors 48 megapixels or larger.

IMAGE CAPTURE 17

Medium format cameras were once the main-
stay of professional wedding and portrait
photography. Today, smaller, 35mm-type
digital models are quickly becoming the
standard. Photographs by Rick Ferro (top)
and Chris Nelson (bottom).

 



Medium format cameras are available as single-lens reflex (SLR) and twin-
lens reflex (TLR) cameras. Like SLRs, TLRs can have interchangeable lens-
es. With a TLR, however, the photographer previews the images through
one lens, and the photograph is taken with the other lens. This has an inter-
esting advantage: since there is no mirror to flip up during the exposure of
the film, the photographer using a TLR can see the exposure while it is
made. This enables the photographer to watch to see if the subject’s eyes are
open and also to see if the flash fired with the shutter. Because the position
of the taking lens is offset from the position of the preview lens, however,
framing problems (especially in close-up images) can be an issue. 
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Today, digital cameras are being used by
photographers in every conceivable situa-
tion—from wedding and portrait photogra-
phy, to commercial and fine-art imaging.
Photograph by Charlene Rule.

 



Digital Cameras
Today, there are literally dozens of
professional digital cameras for the
photographer to choose from.

Where do you begin in making a selection? The easiest way to make an
informed decision is to identify the features that are most important to you
and the type of photography that you will use your digital camera for. It is
important to remember that one single digital camera may not fulfill all of
your photography needs. The following are some features to keep in mind.

Megapixels and Resolution. Resolution refers to the maximum number
of individual picture elements (pixels) that the camera’s sensor can capture.
A megapixel is simply a million pixels. The more pixels your camera has, the
more detail it can capture in each photograph. The more detail you have, the
more you can enlarge a picture before it becomes “grainy” and starts to look
out of focus. Today’s professional digital cameras range from 3 to 18
megapixels in 35mm cameras and 48 megapixels and beyond for medium
format camera backs. 

While having more megapixels available is generally better than having
less, the best determination of camera quality is made by examining the max-
imum enlargement possible from an image file. Any of the professional
35mm digital cameras available can make very acceptable prints up to 24x30
inches. The only time the use of a larger megapixel camera is noticeable is

on very large prints or when the sub-
jects are very small in the photo-
graph. Larger sensors provide more
detail, allowing for larger magnifica-
tion before artifacts are apparent. 

What resolution you need depends
on the work that you do. For exam-
ple, if you shoot a number of large
family groups and routinely sell
20x24-, 30x40-, or 40x60-inch im-
ages to the client, you will need a
digital camera with a large file size,
preferably 12 megapixels or higher.
However, those same cameras may
not be the best choice for photo-
graphing a high-school football or
basketball game. For these types of
events, file size is less important,
because the maximum image size
you may be expected to provide is
usually 8x10 inches or smaller. Speed
is of far greater importance in these
cases. 
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COLOR VS. BLACK & WHITE CAPTURE
Though some digital cameras have a black & white capture setting, I would strongly rec-
ommend capturing all of your images in color. With color capture, you can create a vari-
ety of digital imaging enhancements—from toning, to selective handcoloring, to con-
version to black & white in Adobe Photoshop—with excellent results.

Using digital image-editing software, photographs captured in color can easily be con-
verted into portraits with an elegant handcolored look. Photograph by Penney Adams.

RESOLUTION
The image resolution needed for web use is 72ppi. For printing, it is 240–300ppi. Image
resolution can be adjusted after the shoot using image-editing software.

 



In sports photography, which is all about capturing
the peak action of the subjects, high burst rates are
more critical than high resolutions. Photographs by
Rob Ledwedge (top left and right) and Robert Williams
(left). 

In early digital models, shutter lag was a problem.
With today’s cameras, capturing the peak action in
high-speed situations is less complicated. Photograph
by Jesse Josleyn.



Burst Rate. If speed is critical, you’ll want to con-
sider models with high burst rates—cameras that can
capture several frames per second for a few seconds
before needing to stop and render all of the images.
These are ideal for sporting events and even for wed-
ding photographers who enjoy shooting several
frame sequences in order to capture that perfect
moment for the bride and groom.

Shutter Lag. In the last few years, most of the cam-
era manufacturers have solved many of the problems

that plagued earlier digital cameras. Shutter lag (the time between pressing
the shutter button and when the camera actually records the image) is no
longer a problem with most professional digital cameras. The Fuji profes-
sional digital cameras are slower than the Nikons and Canons but are usual-
ly manageable. Most of the Olympus cameras and the older Nikon 950, 990,
and 995 cameras that we use for infrared imaging (see chapter 5) have some
shutter delay, but you can learn through experience to be aware of this prob-
lem when taking pictures.

CCD vs. CMOS Sensors. In digital cameras, images are captured on
electronic sensors rather than on film. There are two popular types of sen-
sors in most of today’s digital cameras: CCD and CMOS. The first sensors
produced tiny images—only 320x240 pixels—but pixel density has steadily
increased over the years.

CCD (Charge-Coupled Device). CCD sensors use an array of photodiodes,
arranged in a grid pattern, to convert light into electronic signals. All CCD
cameras use interpolation to create images. For example, a 3-megapixel dig-
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Like sports photographers, wedding shoot-
ers often rely on their camera’s speed to
help capture the moment. Photographs by
Travis Hill (left) and Chris Nelson (right).

POLAROIDS
In 1944, Edwin Land, owner of the Polaroid Land company, invented
instant film. Instant film consists of a gelatin coated paper, negative
emulsion, and processing chemicals that are either sandwiched in
layers or applied by the camera to the paper as it is ejected. Instant
films were popular with both consumers and professionals because of
their ability to produce a print of what the camera just photographed
in about sixty seconds. Manufacturers designed medium and large-
format Polaroid backs for their professional cameras to help photog-
raphers produce accurate images for their clients.

 



ital camera only has 750,000 red, 750,000 blue, and 1.5 million green pix-
els, but the camera’s on-board processor generates a 3-million pixel color
image by interpolating the data from each neighboring pixel.

CMOS (Complementary Metal Oxide Semiconductor). CMOS sensors have
some advantages over CCD-type sensors. First, they use only a fraction of
the power required by CCDs, making them a great feature in battery-
powered cameras. Additionally, CMOS sensors are made using the same
techniques and equipment as more familiar CMOS circuits like CPUs and
RAM, so they cost less to produce than CCDs, which require specialized
fabrication equipment.

Like CCDs, CMOS sensors use an array of photodiodes to convert light
into electronic signals. The weak electronic charge generated by the photo-
diode is stored in a small capacitor. The major difference between CCDs and
CMOS sensors is in the way these stored charges are converted into a usable
signal. A CCD sensor scans its pixels consecutively. As it does so, the stored
charges from each row are actually shifted down to the next row. At the bot-
tom of the array, the charges in the final row are output in a serial stream.
The voltage levels of each pixel in the serial stream are maximized by an on-
chip amplifier prior to output and sent to either an external or internal 
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All digital cameras use image sensors to
convert light into image data. How this pro-
cess is executed, however, varies slightly de-
pending on the camera’s design. Photo-
graphs by Dennis Orchard.

 



analog-to-digital converter (ADC),
where the signals are converted into
an array of bytes that makes up the
image.

Each pixel in a CMOS sensor, on
the other hand, has its own amplifier
circuit, so the signal amplification is
performed prior to the image being
scanned. The resulting signal is
strong enough to be used with-
out any further processing. Unlike

CCDs, CMOS sensors often contain additional image-processing circuitry
(including ADC and JPEG compression processors) directly on the chip,
making it easier and faster to retrieve and process the picture information.
This results in a lower number of chips per camera, increased reliability,
reduced power consumption, and a more compact design.

Until the introduction of the first Canon CMOS professional camera, the
Canon D30, CMOS sensors were generally regarded as a low-cost, low-
quality alterative to CCD sensors and were typically found in inexpensive
digital cameras. A major problem in older CMOS sensors was that some pix-
els often had more or less sensitivity than their neighboring pixels. This
unevenness translated into noise. Canon solved the noise problem in the
D30 by scanning the sensor twice—once before the shutter opened, and
again while the shutter was open. The “dark” image was then electronically
subtracted from the exposed image, which virtually eliminated the noise.

Digital Storage Media. Once an image is captured by the image sensor,
the data is stored on the camera’s storage media. The most popular are
microdrives and CompactFlash (CF) cards. 
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Whether it is designed around a CCD or CMOS
image sensor, you can expect to get high-
quality results with any professional digital
camera. Photographs by Chris Nelson (left)
and Rob Ledwedge (right).

DON’T REINVEST
With the innovations of the past couple of years, it doesn’t make that much difference
whether your camera uses a CCD or CMOS sensor. Canon, Nikon, and Fuji are all manufac-
turing great digital cameras that produce outstanding files for the working professional
photographer. While there are differences in the two technologies, the sensor is not nec-
essarily a deciding factor when choosing a camera. My recommendation is quite simple.
If you already own 35mm camera lenses on the Canon platform, then choose one of the
Canon digital cameras. If you own 35mm lenses on the Nikon platform, then choose the
Nikon or Fuji digital camera bodies. The key is to not have to reinvest in new lenses.
This will save you thousands of dollars, and you will get great digital files regardless of
which sensor your camera utilizes.

 



Microdrives. Microdrives came on the market very early in the evolution
of digital imaging. Their advantages were their large storage capacity and fast
read and write speeds in the camera and computer. They were also very in-
expensive compared to the CF and SmartMedia cards. The major disadvan-
tage of microdrives is that they are miniature computer hard drives that have
moving parts enclosed in the housing. This presents two distinct problems.
First, if a microdrive is dropped, it is possible that it may never work again,
and the photographer could lose every image on the microdrive at the time.
This has happened to a number of photographers. The second problem is
that a microdrive, being a computer hard drive, can crash just like any com-
puter hard drive. These factors present a considerable risk for the profession-
al portrait or wedding photographer.

CompactFlash Cards. CF cards are solid-state circuits. With no moving
parts to break, these cards are practically indestructible! I have met three
photographers who have left CF cards in the pockets of their trousers and

24 MASTER GUIDE FOR PROFESSIONAL PHOTOGRAPHERS

HOW DIGITAL CAMERAS 
CREATE COLOR
CCD and CMOS sensors are sensitive only
to the amount of light striking them, not
to the color of the light. To create color,
a mosaic filter called a Bayer filter is
used. These filters feature a checkerboard
pattern of alternating rows of color (red,
green, and blue). Specialized algorithms
then convert the mosaic of separate col-
ors into an image.

When you’re in the moment, the last thing you want to do is stop to switch memory cards.
Therefore, it makes sense to work with larger memory cards and minimize the number of card
changes that need to be made. In some cases (say, just before an important event at a wed-
ding), you may want to switch to a fresh card just to be sure you won’t need to stop shoot-
ing in the middle of the event. Photographs courtesy of Drew Smith (left) and Visualizations
Photography (right). 

 



sent them through the washing machine and dryer without harming the card
or the images recorded on it. CF cards were initially very expensive, had lim-
ited storage capacity, and very slow read and write speeds. This has all
changed. The prices of CF cards have dropped dramatically—so much so
that they are usually less expensive than microdrives of the same storage size.
Additionally, the storage capacity for CF cards has actually surpassed that of
microdrives. Lexar Media and SanDisk offer 1-, 2-, 4-, and 8-gigabyte CF
cards for professional photographers. These large-capacity cards can store
hundreds of files and can be used with the latest high-resolution cameras.
Finally, the read and write speeds of professional CF cards have also sur-
passed that of microdrives, making them extremely efficient to use.

Card Readers. A card reader is a computer interface accessory that enables
the computer to read data from digital media cards. These are built into
many newer computers or can be added to a computer through a USB 
connection.

Image File Formats. A file format is the “language” in which a digital
image is written. There are three main formats of concern to photographers. 

TIFF (.tif). The TIFF file format employs a “lossless” compression called
LZW, which means that when the file is compressed, no image data is
thrown out. While this ensures better image quality, it also means that the
files are not compressed as much as JPEG files. Compared to a JPEG file,
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CompactFlash cards are very durable, making
them great for wedding photography and
other situations where your equipment is
constantly being moved around. Photograph
by Michael Ayers.

 



therefore, an image saved as a TIFF file will take up much more space on
your memory card and will use up more of your computer’s memory. Also,
when an image is captured in the TIFF format, the camera makes certain
automatic image adjustments (unlike with RAW files, where these can be
applied selectively by the photographer after the shoot).

JPEG (.jpg). The JPEG file format employs a “lossy” compression algo-
rithm, which means that data is thrown away in order to minimize the file
size and cannot be recovered at a later time. The benefit of this format is its
much smaller file sizes. This means the camera can process each file more
quickly (i.e., you can shoot faster) and the memory card can hold more
images (i.e., you can shoot more images before having to switch the card
out). Like TIFF images, JPEGs are subject to some automatic in-camera
image adjustments.

RAW (.raw). When you shoot in your camera’s RAW mode, no contrast,
sharpness, saturation, or color balance adjustments are applied to your image
by the camera. Instead, these changes can be applied to individual files (or
groups of files) after the shoot. This allows for maximum flexibility.
Additionally, images recorded in the RAW mode are not compressed. This
means that all the data captured by the images sensor is preserved, resulting
in maximum image quality. However, these uncompressed files are big,
requiring more time to process in the camera and more space on your mem-
ory card (and, later, on your computer). While opening and processing RAW
camera files used to require special software, Photoshop now comes with the
software needed to work with these files.

ISO Ratings. One of the real advantages of digital photography is the
ability to choose and change ISO speeds at will. With film, you are virtually
stuck with the film as rated by the manufacturer. When you want to change
to a different ISO film, you have to use all of the film in the camera and then
switch rolls (or, with some cameras, switch film backs). This is not the case

26 MASTER GUIDE FOR PROFESSIONAL PHOTOGRAPHERS

The file format you select will depend on
your final intent for the image (i.e., how
much you intend to enlarge it), as well as
your shooting needs. You might select JPEG
for photojournalistic portraits that include
motion (left) but switch to the RAW mode
for a posed studio portrait where time is less
critical (right). Photographs by Ken Holida. 

 



with digital. With digital photography, you can change the ISO setting from
shot to shot, allowing you to optimize your camera settings for whatever
lighting conditions you encounter. Outdoors on a bright day, you may
choose a low ISO rating of 100 or 200. Indoors with flash, you may set the
ISO to 400. If flash photography is not desired or possible, you can change
the ISO to 1600 and beyond. The photographer has complete control and
flexibility.

As you increase the ISO rating on your digital camera, the camera
becomes more light sensitive. In other words, you can take photographs in
lower light situations. However, just like film, as the ISO rating goes up, so
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RAW OR JPEG? BY MICHAEL AYERS
“Do you shoot in RAW or JPEG mode?” The
answer, for me, is both. Most people believe
that RAW mode gives you the best images and
JPEG is best used for quick and easy snapshots.
The truth is, both modes have their advantages
and disadvantages.  

RAW mode allows the user to produce the
highest resolution image. Also, with many high-
end digital cameras, an image captured in RAW
mode and overexposed by even a full stop can
be brought back to the correct exposure. This
“safety net” is one of the biggest advantages of
RAW mode, since some photo opportunities are
gone for good once the moment has passed.

However, JPEG still has some advantages.
First, in most cameras, the JPEG mode has a
quicker acquisition time, thus allowing the pho-
tographer to be ready for the next big moment.
Second, with the smaller file size you can get
more images on a CompactFlash card or micro-
drive. Third, you can get a great enlargement
with a JPEG. Fourth, most labs cannot process
a RAW file (you have to convert the image to
JPEG before sending it to the lab, which means
an extra step in the process). A JPEG image, on
the other hand, usually needs no conversion for
a lab to process it. 

In recent tests I have conducted I have seen
the same quality in the final print from both
RAW and JPEG files. The key here is obviously
correct exposure on the front end and a good
lab on the back end. It is also important that
you know what your end product is going to be.
For me it is pretty simple. Few if any clients will
order a 20x30-inch wall portrait of the best man
giving a toast. A JPEG will easily give you a
16x20-inch print, so shooting this type of image in JPEG is a good call. If you know the end product will be a 30x40-inch print (say, for
a formal portrait of the bride and groom) or you need that “safety net” for exposure, then RAW mode may be your best choice. 



does grain in the final image. This can sometimes be seen as a creative effect,
sort of Monet-like in quality, but is more often considered a problem in an
image. When using a high ISO is your only option (such as a very dark
church), digital grain can also be reduced with programs like Applied
Science Fiction’s Digital GEM Photoshop plug-in. 

Viewfinders and LCDs. Digital cameras allow users to use the viewfind-
er, the small window on the back of the camera, to compose their images, as
is done with film cameras. They also feature LCD (liquid crystal display)
monitors that allow you to review your images post-capture—or share them
with your clients. The viewfinder is also your means of interacting with the
camera. You can use the menus displayed on the monitor, in concert with
your camera’s buttons or dials, to select the desired settings. (Note: Digital
point & shoot cameras, unlike SLRs, also allow you to use the LCD to com-
pose your images.)
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Photographers encounter a variety of light-
ing situations. With digital, you can set your
ISO individually for each shot. Photographs
by Rick Ferro (left) and Travis Hill (above).

 



Flash Photography. In many photographic situations, there is not
enough ambient light to record the image the desired way. In these cases,
the photographer will need a portable flash unit or studio lights to properly
illuminate their subject. Both Canon and Nikon have introduced specific
flash units designed to be used with their digital cameras. These dedicated
portable strobes optimize all of the camera’s features and allow for total inte-
gration of features and performance. For example, with Canon digital cam-
eras, when using their 580 EX flashes, the camera can have flash synchro-
nization from 30 seconds up to 1/8000 second. If you use a non-Canon flash,
the flash synchronization is from 30 seconds to only 1/250 second. 

Don’t let a dead battery stop you from cap-
turing an amazing image—be sure to pack
extras for all your cameras. Photograph by
Dennis Orchard.

 



Photographers can certainly still use their third-party strobe units (e.g.,
Metz, Quantum, Lumedyne, Vivitar, etc.) with their digital cameras. How-
ever, there is a remote possibility that you can short out your camera when
doing so. Strobe units that are matched to the camera produce a regulated
amount of voltage into the camera through the camera’s hot shoe. Third-
party strobe units may produce variable amounts of voltage and burn up the
electronics in the camera. To avoid this problem, you can use a product
called a safe sync, which regulates the voltage from the portable flash and
prevents a power surge. These units cost about $60, fit right on top of the
hot shoe mount on the camera, and have a PC cord plug on them. (Note: If
you fire your flash equipment or studio
strobes via radio slaves, you do not
have to be concerned with this prob-
lem since the radio slave generates a
very low voltage current.)

Batteries. Professional digital cam-
eras typically run on rechargeable bat-
teries (although some can also be
plugged in for shooting in the studio).
The battery life you can expect varies
from camera to camera and will depend greatly on how you shoot. One
thing is for sure though: you’ll need extra batteries and you’ll need to make
sure they are charged before every shoot. If you carry one or more backup
cameras (which is always a good idea) on your assignments, or if you work
with an assistant who also shoots, be sure to have backup batteries for these
cameras as well. Dead batteries can leave you dead in the water.
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MOIRÉ
With some digital cameras, when you photograph a subject whose clothing features a
regular pattern of stitching or weaving, a strange pattern of stripes and/or colors
unrelated to the original pattern in the subject may appear in the shot. This is
referred to as a moiré effect. A moiré pattern is a two-dimensional “beat” captured by
the camera as a result of the interaction between the regular pattern on the subject
and the regular pattern of the CCD pickup element in some digital cameras. Moiré pat-
terns only affect digital cameras and do not occur with film cameras. This is because
there is no regular pattern in the distribution of light-sensitive material on film.

The instant feedback of digital allows you to
instantly check the accuracy of your expo-
sure, focusing, and composition. Photo-
graph by Dennis Orchard.

 



Alens is a piece of precisely shaped optical glass. Camera lenses contain 
multiple pieces of this optical glass used in sequence to focus the light

reflected from a scene or subject onto the recording medium (be it film or a
digital sensor) with maximum sharpness and minimal distortion. Point &
shoot cameras typically have a fixed (permanent) lens; SLRs can accept a
variety of interchangeable lenses. 

Qualities of Lenses
Focal Length. Lenses are described according to their focal length or range
of focal lengths. The focal length of the lens (measured in millimeters [mm])
determines the way that the scene is recorded, both in terms of the angle 
of view and the perspective relationship between the subject and the 
background. 

Normal Lenses. A normal lens is one that approximates the angle of view
we see with our eyes. The focal length measurement for a normal lens, how-
ever, will change depending upon the film/sensor size being used. A normal
lens on a 35mm camera is a 50mm lens, while a normal lens on a medium
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2. LENSES

Normal and telephoto lenses are common
choices for portrait photography (although
telephotos are generally preferred, as noted
on page 33). Photograph by Chris Nelson.

 



format camera is an 80mm lens. For
digital cameras, see the sidebar to the
right. Normal lenses are generally very
sharp and very fast. 

Wide-Angle Lenses. Wide-angle lens-
es are sometimes referred to as short
lenses because they have focal lengths
shorter than a normal lens. These lens-
es provide a wider field of view than the
human eye can see. This makes them
ideal for photographing large groups,
recording vast landscapes, or working in tight spaces. Inexpensive 35mm 
single-use cameras are often equipped with such lenses.

Telephoto Lenses. A telephoto lens is a lens with a focal length longer than
a normal lens. Telephoto lenses (also called long lenses) provide greater
image magnification than a normal lens, allowing the photographer to
record subjects from a greater distance. This is useful when you simply can-
not get as close to the subject as you would like (such as at a sporting event),
when getting closer would be undesirable (such as when taking candid shots

FOCAL-LENGTH FACTORS
On digital cameras, where the size of the image sensor varies from model to model but
is typically smaller than a 35mm film frame, focal lengths are often given in 35mm
equivalents. To understand how the lens will actually function, then, you must know
the value of the focal-length factor for the camera on which the lens will be used.
Typically, this is in the 1.3x to 1.6x range. For example, if you were using a 50mm lens
on a camera with a 1.5x focal-length factor, the lens would actually provide an angle
of view and perspective equivalent to a 75mm lens (50 x 1.5 = 75) on a 35mm cam-
era. As you can see, because the image sensor on a digital camera is smaller than a
35mm film frame, a 50mm (or any other) lens will provide results that are slightly more
telephoto. This is not because the lens really magnified the subject, but rather because
the sensor is smaller and, therefore, records a smaller portion of the scene.

Wide-angle lenses are frequently used to
capture the majesty of a vast landscape.
Photograph by Bob Knuff.

 



at a wedding), or when approaching the sub-
ject would be dangerous (when photograph-
ing wild animals, for instance).

For portraiture, most photographers use
telephoto lenses. These telephoto lenses pro-
vide a compression of the subject and back-
ground that is very flattering. Telephoto lens-
es also have a shallower depth of field, which
keeps the backgrounds less in focus and less
distracting. In the days of medium format
cameras and lenses, a photographer would
generally use a 150mm or 180mm lens for
portrait work. With 35mm film cameras and
lenses, the recommended focal length for por-
traiture is 135mm. 

With digital cameras, as noted on the facing
page, the correct lens for portraiture depends
on the magnification of the digital camera.
Let’s look at an example. If your camera has a
1.6x magnification factor, the lens has an
effective focal length that is 60 percent
greater than the focal length listed by the
manufacturer. In other words, when used
with this camera, a 100mm lens would be
effectively a 160mm lens. A 90mm lens would
function as a 135mm lens on this camera.
These moderate telephoto focal lengths
would, therefore, make either of these lenses
a good choice when creating a portrait.

Prime Lenses vs. Zoom Lenses. Prime lenses
are lenses with only one focal length. While

these are considered by many photographers to produce superior results,
other professionals swear by zoom lenses—lenses that feature multiple focal
lengths. These lenses feature internal glass elements that move in relation to
each other and thus change the image size being rendered. This allows pho-
tographers to go from a close-up to a full-length image very quickly, with-
out changing the lens. Note that the rules used to determine the effective
focal length of a lens on a digital camera apply to both prime and zoom lens-
es (see facing page).

Perspective. Perspective refers to the relative size and depth of objects
within a scene. This is controlled by the lens-to-subject distance. 

For instance, with a wide-angle lens, objects very close to the lens appear
to be stretched to unnaturally large dimensions. This effect can be creative-
ly utilized by photographers to achieve dramatic images that emphasize the
importance of the object.
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Telephoto lenses are a great choice when it’s not possible to get close to your sub-
jects. Photograph by Drew Smith.

 



Telephoto lenses, used at a great distance from the subject, will create a
perspective error called the telephoto effect. The telephoto effect compress-
es subjects in a scene and makes them appear very close to each other when
in reality they are not. This effect can also be utilized for creative impact.

Maximum Aperture. Lenses are also rated according to their maximum
apertures. This is the width of the opening in the lens (described as an f-stop
[f/]) that allows light to strike the film/sensor. Most normal lenses have
maximum apertures of f/2.8, f/2.0, f/1.8, or f/1.4.

The camera’s aperture setting controls the amount of depth of field in a
photograph. Depth of field is the area between the nearest and the farthest
points from the camera that are acceptably sharp in the image. The smaller
the aperture, the more depth of field in the photograph. Also, with smaller
apertures, more of the background of the image remains in focus. Though
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Using a zoom lens allows photographers to
go from a close-up to a full-length image
very quickly, and without changing the lens.
Photographs by Ed Vullo.

 



it may seem counterintuitive, there is actually an inverse relationship between
the size of the aperture and the number used to represent it. For example,
an aperture setting of f/16 is smaller than one of f/2.5.

The maximum aperture also has an affect on exposure. When a lens offers
a very wide maximum aperture, it is considered “fast” because using a wide
aperture allows the photographer to use a quicker shutter speed. This makes
it easier to create low-light images, shoot handheld photographs, and freeze
fast action in the frame. For more on exposure, see chapter 3.

Zoom lenses, it should be noted, have either a fixed maximum aperture
or floating maximum aperture. A fixed maximum aperture means that the
aperture will stay the same regardless of the focal length chosen. A floating
aperture means that the maximum aperture will decrease as the focal length
increases. With some less expensive zoom lenses, this can be a change of 2–3
stops. 

Close-up Photography
When photographing small subjects, it’s often desirable to get closer than
your regular lens will allow you to focus. When that happens, the following
tools can be useful.

Teleconverters. A teleconverter is a secondary lens that is placed between
the lens and the camera body to increase the focal length of the lens (mak-
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Zoom lenses work well for wedding photog-
raphy, where great shots are appearing at
different distances all around you. Photo-
graphs by Patrick Rice.

HANDHOLDING
The rule of thumb for being able to
handhold a lens is use the shutter speed
that is the closest inverse to the focal
length of the lens. For example, if you
are using a 50mm lens, you should be
able to handhold the camera to approx-
imately 1/50 (the closest setting on most
cameras will be 1/60 second). If you are
using longer focal length lenses, the
minimum shutter speed will increase
accordingly. For instance, you should
not hand hold a 300mm lens at shutter 
speeds slower than 1/300 second.

 



ing it enlarge the subject more). These are sometimes referred to as doublers
because they usually have a 2x designation (i.e., they double the focal
length), but teleconverters can also be purchased for some cameras at 3x
magnification. The downside of teleconverters is that they can cause a loss
of image sharpness. In addition, all teleconverters reduce the light that
reaches the lens or sensor. A 2x teleconverter, for instance, will lose 2 stops
of light from the lens’s maximum aperture. In other words, a 200mm f/2.8
lens will effectively function as a 200mm f/5.6 lens. 

Macro Lenses. Macro lenses are specifically designed for taking close-up
photos. These lenses have specially designed lens barrels that can be extend-
ed farther than a normal lens. By extending the lens barrel, you can focus
closer than a normal lens would allow. In addition, all macro lenses are
designed to reduce aberrations that are normally associated with focusing in
very close to an object. Macro lenses provide edge-to-edge sharpness at very
close distances. 

Close-up Lenses. Close-up lenses, sometimes referred to as close-up fil-
ters, are inexpensive lenses that are fitted to the front of a regular camera
lens. These lenses magnify the focal length of the lens and tend to produce
sharp images only when used with small apertures. They also produce images
with a very shallow depth of field.
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Photographing tiny subjects often requires
you to get closer than your regular lens will
allow. Photograph by Michael Ayers.

 



Extension Tubes and Bellows. Extension tubes and bellows are hollow
devices that are mounted in between the camera body and the lens. By
extending the lens farther from the film/sensor, these devices allow you to
focus in closer to the subject. The closer you move the lens to the subject,
the larger it will be recorded on the film/sensor.

Most extension tubes are metal rings of designated sizes that are placed
between the camera and lens. The rings are available in graduated sizes, and
each provides a specific magnification. Extension tubes can be attached to
each other to increase the magnification effect of the tubes.

Bellows are flexible extension devices that can extend the distance
between the camera body and the lens at various lengths. Because bellows
are adjustable, they are far more versatile than extension tubes. Bellows are
generally more expensive than extension tunes.

Both extension tubes and bellows allow for great close-up images. They
can provide high-quality, larger-than-life images of a subject.

Close-up photos often feature an extremely
reduced depth of field. This can make your
tiny subject pop out dramatically from a
very soft background, as seen in this image.
Photograph by Debora Woodward.

 



Specialized Lenses
The Fisheye Lens. The fisheye camera lens, an extreme wide-angle lens, is
one of the most intriguing of all lenses used in photography. Some fisheye
lenses can record 180 degrees of the scene, giving the impression that all
objects in the scene curve around the center. It is this distortion of reality
that has elevated fisheye lens photography to an art form in recent years. 

The biggest problem with fisheye lenses is that they can sometimes see too
much of what you are photographing. In fact, the most common mistake
made with a fisheye lens is getting people who are standing off to the side of
your camera position in the picture. Most people are not accustomed to the
extremely wide field of view of the fisheye lens and will think they are out of
the way when, in reality, they are not. Therefore, it is imperative that you
scan the perimeter of the frame to eliminate distractions. 

Lens flare from the sun is another common problem with fisheye lenses.
Because of the extreme angle of view of a fisheye lens, it is very easy to
include the sun in your photographs.

Perspective Control Lenses. Perspective control (PC) lenses, also called
shift lenses, are popular with commercial photographers, who need to con-
trol the perspectives of objects in a scene. These lenses can straighten verti-
cal lines so that tall objects do not appear to lean toward the center of the
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When using a fisheye lens, placing your sub-
jects in the center of the frame will keep
them from appearing distorted. In this
image (facing page), notice how the car and
landscape curve around to encircle the bride
and groom. This is the effect created by the
fisheye lens. With any other lens, these lines
would be straight diagonals. Photograph by
Dennis Orchard.

The Lensbaby provides only a pinpoint area of focus in the picture, with a smooth blur over the rest of the frame. With the right subject, it
can create an extremely effective image. Photograph courtesy of LisaSmithStudios.com. 

 





image. PC lenses operate somewhat like a view camera and have some shift
capability. These lenses have a built-in bellows system, and the front element
of the lens can be shifted up or down by turning the lens control knobs.

Lensbaby. Photographer Craig Strong invented a specialized lens that he
calls the Lensbaby. The Lensbaby mounts on your camera like any other lens
but provides a pinpoint area of focus in the picture. This inexpensive lens
allows for the manual control of lens tilts and swings (like a view camera) and
creates a “sweet spot” of focus while the rest of the image appears to be
affected by motion blur. Plastic invertible aperture rings allow you to change
the effective aperture.

Focusing 
As a camera lens focuses, the lens barrel rotates to the position at which rays
of light from the lens converge to form a sharp image on the film/sensor.
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In portraiture, a shallow depth of field (top)
can be used to subdue the background and
keep the focus on the subjects. A wider
depth of field (bottom) keeps the back-
ground more sharp, allowing it to play a
greater role in the photograph. Photographs
by Chris Nelson.

 



While image-editing software includes filters to enhance the sharpness of
digital images, these are definitely no substitute for careful and accurate
focusing when shooting. Proper focus is critical to a successful image.

The closer an object is to the lens, the farther the lens has to be from the
film/sensor to achieve sharp focus. All lenses focus sharply at a single point
in the distance. This is called the plane of critical focus. Anything at that dis-
tance from the lens will be sharply focused, while objects closer and farther
from that point will be less sharp. This is not to say that those objects won’t
appear acceptably sharp, they just won’t be completely sharp. The acceptably
sharp area of a photograph is referred to as the depth of field. How great an
area this spans will be determined by the aperture (see page 46) and the lens
selection (see pages 31–35).

Manual Focus. On a manual focus camera (or with a camera set to the
manual focus mode), the photographer rotates the lens barrel until he
achieves a sharp image. 

When using manual focus, it can be helpful to use a procedure called zone
focusing. Zone focusing means setting the lens at the distance that you think
your subject is at and relying on the aperture’s depth of field to maintain
acceptable sharpness in the photograph. With manual focus cameras, I rou-
tinely zone focus while taking photographs at wedding receptions. In these
very dimly lit situations, it is sometimes difficult to see the subjects well
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Accurate focusing can be tricky with sub-
jects that are in motion, but it’s critical 
to producing professional-quality images.
Photograph by Dennis Orchard.

SELECTIVE FOCUS
A person viewing a photograph tends to
look at the area of a photograph that is
in focus before they see anything that is
out of focus. Therefore, focus can be
used to direct the viewer to the particu-
lar portion of the photograph that the
photographer deems the most important.

 



enough to focus the camera, so zone focusing makes it easier to get sharp
pictures of people dancing. I employ this technique even with my modern
digital cameras when there is not sufficient light for the digital SLR’s focus-
ing system to lock focus quickly enough.

Many photographers employ a diopter to help them manually focus their
camera. This is a supplemental lens that fits over (or is built into) the cam-
era’s eyepiece for vision correction. Many modern cameras include diopters
that can be dialed in to best match the photographer’s vision. I can always
tell when another photographer at my studio has used my camera—I’ll pick
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More expensive cameras allow the photogra-
pher to move the focusing spot around the
viewfinder. This makes it easier to focus 
on the off-center subjects included in most
effective compositions. Photographs by 
Barbara Rice (top) and Debora Woodward
(bottom).



up the camera to photograph a subject and the focus will lock, but the image
will appear somewhat blurry. That’s when I realize that the diopter setting
has been changed. Once I adjust the diopter back to my setting, everything
appears sharp again.

Autofocus. When you press the shutter button on your autofocus cam-
era, it will focus on the spot that the focusing target area strikes. In less
expensive cameras, the focus spot is directly in the middle of the viewfinder.
More expensive cameras allow the photographer to move the focusing spot
around the viewfinder to easily create differing compositions. Better cameras
with superior autofocus technology will also focus more quickly than inferi-
or cameras. 

Cameras can be equipped with active or passive autofocusing systems
(some cameras feature both). Active autofocus measures the distance to the
subject by bouncing an infrared beam of light or high-frequency sound
waves off of it. In a passive autofocus system, a computer analysis is made by
the camera to determine the subject’s distance. A camera with a passive
focusing system will have trouble focusing accurately in low-light situations
and in low-contrast scenes. The camera “fishes” for focus, with the lens mov-
ing back and forth, attempting to lock onto a focus point. 

Lens Flare
Lens flare is characterized by a reduction in contrast and, often, strings of
geometric highlights across the frame. It occurs when a very bright light
source (such as the sun) is recorded in the image or its light rays are direct-
ly striking the front of the lens. Under these conditions, non–image forming
light scatters and is reflected inside the lens and/or camera. 
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Today’s autofocus cameras include sophisti-
cated systems that even allow you to track
the motion of a moving subject. Photograph
by Dennis Orchard.

 



Adjusting your camera position or using UV-coated lenses and filters can
help to eliminate or reduce the effect.  Better yet, use a lens shade to keep
stray light away from the lens. Keep in mind that different lens shades are
designed to work with different lenses. Long telephoto lenses, for example,
generally have long lens shades. Wide-angle lenses, on the other hand,
require a very wide and thin lens shade to prevent vignetting. (This occurs
when the lens shade is recorded in the corners of the photograph. This gen-
erally results in a darkening of the corners matching the shape of the lens
shade.) Lens shades are especially important with digital photography,
because the scattering of stray light on the lens and sensor will diminish the
overall quality of the file.

Lens Cleaning
Some photographers are notorious for never cleaning their lenses. However,
the presence of dirt, dust, smudges, and fingerprints on the lens will deteri-
orate the quality of the image. This is even more important with digital pho-
tography. Dirt and smudges degrade digital image quality and can be seen as
dark spots in your image files. Make it a habit to clean your lenses regularly,
and always keep a lens cloth on hand.
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Lens flare isn’t always a bad thing. As this
image from Dennis Orchard demonstrates, in
the hands of a master photographer, it can
be used to great effect!

 



When you take a picture, getting deep, saturated black tones with
detail, bright whites with detail, and good, accurate color is impor-

tant. If an image is overexposed (your camera lets in too much light), the
image may be washed out and the highlights (the brightest areas of the
scene) will lack detail. When there is not enough light striking the film or
image sensor, the image will be underexposed and the shadow areas (dark-
est parts of the scene) will lack detail. 
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Accurate exposure is critical to producing
professional-quality images. Photograph by
Jesse Josleyn.

 



There are three main factors that determine the amount of light that is
used to create the image, and whether your exposure will be acceptable. The
first factor, film speed/ISO rating, was covered in chapter 1. Below, we’ll
look at how your aperture and shutter speed selection will affect your image.

Aperture
In the previous chapter, we described the impact of the aperture on the
depth of field in the image. It is also important to note that the aperture you
choose determines the amount of light that is allowed to strike the film/sen-
sor. Therefore, the aperture setting also has an affect on the overall exposure
of the image. The smaller the aperture, the less light reaches the film. The
larger the aperture, the more light reaches the film. To “open up” is to
increase the size of the lens aperture. It is the opposite of “stopping down.” 

With each full-stop change in the aperture, the amount of light striking
the film/sensor is either doubled or halved. It may be helpful to review the
chart below to better understand the relationship between the aperture size
and the amount of light used to make the exposure.

f/2.8—Twice as much light as f/4
f/4—Half as much light as f/2.8, twice as much light as f/5.6
f/5.6—Half as much light as f/4, twice as much light as f/8
f/8—Half as much light as f/5.6, twice as much light as f/11
f/11—Half as much light as f/8, twice as much light as f/16
f/16—half as much light as f/11, twice as much light as f/22
f/22—Half as much light as f/16

Shutter Speed
The shutter speed refers to the amount of time that the camera’s shutter
remains open, allowing light to strike the film/sensor. The shutter speed is
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Choosing a wider aperture lets more light
into the camera. This allows you to select a
faster shutter speed in order to freeze mov-
ing subjects in the frame. Photograph by
Dennis Orchard.

APERTURE AND SHUTTER SPEED
Shutter speeds in one stop increments
are: 1, 1/2, 1/4, 1/8, 1/15, 1/30, 1/60, 1/125, 1/250,
1/500, 1/1000, 1/2000, 1/4000, and 1/8000 second.
Most cameras drop the “1” and just
show the bottom number.

Aperture settings in whole stops are:
f/1.4, f/1.8, f/2.0, f/2.8, f/4.0, f/5.6,
f/8.0, f/11.0, f/16.0, f/22.0, f/32.0

There is a reciprical relationship
between the shutter speed and aperture
setting to create equivalent exposures.
For example, reducing the aperture by
one stop can be compensated for  in-
creasing the shutter speed by one step.

 



usually rated in fractions of a second, though photographers sometimes use
long exposures (a second or several minutes, for example) to photograph in
low-light situations.

The slower the shutter speed, the greater the amount of light that reach-
es the film. The faster the shutter speed, the less the amount of light that
reaches the film. Each full-stop change in the shutter speed means that the
amount of light striking the film/sensor is doubled or halved.

Fast shutter speeds are typically used to control exposure in brightly lit sit-
uations or to freeze moving subjects. Faster shutter speeds also help to alle-
viate the effects of camera shake, a blurring that sometimes occurs due to
camera movement when handholding the camera. 

Long shutter speeds are used to allow more light into the camera in low-
light situations. They can also be used to blur moving subjects, accentuating
the motion as a blur across the frame. When using long shutter speeds, there
is an increased risk of blurring due to camera movement. Therefore, the
camera should usually be tripod-mounted or otherwise stabilized. You may
even wish to use a cable release or remote to trip the shutter without touch-
ing the camera (and potentially moving it).
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Long shutter speeds can be used to capture
moving subjects as a blur. The longer the
shutter speed, the more the subjects will
blur. Photograph by Patrick Rice.

 



To further increase picture sharpness, a photographer can lock up the
camera’s mirror. In most SLR cameras, the photographer sees the scene
through a viewfinder and mirror that allows you to see through the lens.
When the shutter is triggered, the mirror flips up and out of the way to allow
light to reach the film or the sensor. The movement of the mirror can cause
some camera shake, which can result in an image that is less sharp. 

Light Meters
A light meter is a device that measures the light falling on a scene/subject
or reflected by a scene/subject. Based on this measurement, the meter rec-
ommends a particular aperture, shutter speed, and ISO combination that
will produce a well-exposed image. There are two basic types of meters for
photography: reflected light meters and inci-
dent light meters. 

Reflected Light Meters. All meters that are
built into cameras and some handheld meters
are reflected light meters. The photographer
points the light-measuring portion of the
meter (usually a dome on handheld meters) at
the subject and measures the amount of light
that is reflected from the subject. 

Because this type of meter measures the
light reflected from the subject, the tone and
color of the area you target with the camera’s
meter will determine the exposure settings it
provides. For example, when a camera meter
targets a white area of the subject, it will deter-
mine you need less exposure than if it targets a
black area of the subject. 

To combat this, more advanced digital cam-
eras measure multiple areas of the scene to pro-
vide an accurate average reading. If your cam-
era does not offer this option, you can also
improve your reflected light metering results
by using a gray card. These cards, available
from any photography supply store, are a solid,
medium gray tone. When you place this card in
the same light as your subject and meter off the
card (rather than the subject), you can be
assured of a proper reading.

Most reflected light meters have an angle of
view of about 50 degrees, similar to a normal
lens. A spot meter, however, is a reflected light
meter that has a much smaller angle of view.
This provides an accurate measurement of a
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PANNING
One way to capture a moving subject is
called panning. To pan is to follow the
movement of an object with the camera.
This will cause the subject to look
sharp, but the background will be
blurred.

Because they can be used from a distance, reflected light meters are a great
choice for situations where you and your subject are in separate areas that are
not under the same lighting. Photograph by Chris Nelson.

 



particular spot in the scene (for example, your subject’s skin tone). Some
spot meters can have as little as a 1-degree angle of view.

Incident Light Meters. Another type of meter is an incident light meter.
Incident light meters measure the light falling onto the subject, so they pro-
vide an accurate reading regardless of the color or tonality of the subject. An
incident light meter is held at the subject position and pointed back toward
the camera. Incident light meters have a very wide angle of view, up to 180
degrees.

Other Options. Many popular handheld meters have reflected, incident,
and spot metering capabilities. These meters give the photographer the most
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Incident light meters must be placed close
to the subject and pointed back toward the
camera. This makes them ideal for many por-
trait situations—including here, where the
backlighting might fool a reflected light
meter. Photograph by Chris Nelson.

 



flexibility to make the right metering choice depending on the subject and
photographic conditions.

Some meters display an exposure value (EV) reading, which provides a
choice of compatible shutter speeds and aperture settings. This allows the
photographer to choose the appropriate settings depending on the subject
being photographed and how much depth of field is desired in the photo-
graph. For a fast moving subject, the photographer would want the fastest
shutter speed in order to freeze the motion. This fast shutter speed would
require a corresponding large lens opening to allow more light. However, if
the photographer was working with a family group consisting of several peo-
ple in rows, he would want a smaller lens opening for maximum depth of
field. This small lens opening would require a slower shutter speed to allow
more light to be recorded.

Another common type of meter in photography is a flash meter. This
measures the light output from a portable flash unit or studio strobe light.
An essential tool in the studio, a flash meter allows the photographer to
measure each light individually and create the desired light ratio on the sub-
ject. (For more information on light ratios, see pages 76–78.)
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Maintaining the delicate detail in highlight
areas of your digital image requires accurate
exposure metering techniques. Photograph
by Barbara Rice.

 



A color temperature meter (or color meter) measures the color tempera-
ture of the light in a scene (see page 9). This is used frequently by commer-
cial photographers to ensure that the colors in their images will be properly
recorded. 

Exposure Techniques
Expose for the Proper Medium. With any exposure, film or digital, it is
best to be accurate. You must also keep in mind the medium you are using
to create your images. With digital and transparency film, you should gener-
ally expose to preserve detail in the highlights, since these media are prone
to blowing out these areas. With negative film, the opposite is true; shadows
tend to block up (lose detail), so you need to expose to ensure these areas
are correctly rendered.

Bracketing. If you’re not sure that you’ve selected precisely the right
camera settings, it’s a good idea to bracket your exposure. This means mak-
ing several exposures, some greater and some less than the calculated expo-
sure, to ensure a good exposure. Bracketing is sometimes used when it is too
costly or not possible to photograph the subject over again in the event of a
problem.

Exposure Compensation. Most cameras offer a handy feature called
exposure compensation. If you are shooting a scene in which the tones are
predominantly light or dark (e.g., a snowman against a snow-covered land-
scape or a dark-gray kitten asleep on a black carpet), then you may wish to
use exposure compensation to improve your odds of getting a good expo-
sure. For primarily light-toned images, shoot the scene with an exposure
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When you find that once-in-a-lifetime photo
opportunity, bracketing can help ensure
that you walk away with a perfect exposure.
Photograph by Rob Ledwedge.

 



compensation value of +1. For an image comprised of mostly dark tones,
select an exposure compensation value of –1.

Analyzing the Exposure
A great advantage of digital photography over film is that you can immedi-
ately check your results to ensure a proper exposure. If you determine that
you didn’t get it right (or just want a little insurance), you can simply
reshoot on the spot. There are three ways to check your exposure. 

Check the LCD Screen. The simplest way to check exposure is to pre-
view your image on the camera’s LCD screen. Keep in mind, however, that
different lighting conditions (e.g., bright light falling on the LCD screen)
and screen brightness settings will impact how the image appears. Therefore,
the LCD screen should be used only as a guide. You should not rely on it
for making critical exposure evaluations.  

Activate the Overexposure Indicator. Because the bright highlights in
digital images are a common source of problems, many digital cameras have
an overexposure indicator. When this is active, overexposed areas of the
image will blink to indicate areas where the highlights are blown out. While
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A great advantage of digital photography
over film is that you can immediately check
your results to ensure a proper exposure.
Photograph by Barbara Rice.

 



this does not provide you with the same detailed image information as eval-
uating a histogram (see below), it can come in handy when you’re shooting
in a hurry or when you just need to confirm a suspected problem. See your
owner’s manual to determine whether your camera model offers this feature.

The Histogram. The histogram is a graphic representation of all the
tones in an individual image. These are plotted on a scale from 0 (black) to
255 (white), with each pixel in the image placed on the scale at a point rel-
ative to its brightness. Pixels of the same brightness are stacked on top of
each other to form a line of various lengths. When all the pixels are plotted,
they form a curve or a series of spikes on the bar chart. 

To read a histogram, you simply need to look at the height of the his-
togram data over the various values in the tonal scale. In particular, you
should look to ensure that the data does not extend quite to the edges of the
scale or feature a large spike at either edge of the scale. This reveals, at the
light end of the scale, that there are areas of pure white (i.e., white with no
detail—meaning the highlights are blown out). At the dark end of the scale,
it indicates that there are areas of pure black (i.e., black with no detail—
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The histogram (left) for this image (below) fills the scale from left to right but also falls just
within the left and the right end points. This is a good indicator that the exposure is right
on and that you have a very printable image. Photograph by Monte Zucker.

HISTOGRAMS
A histogram represents of range of tonal
values in a scene from 0 (absolute
black) to 255 (absolute white). Middle
gray is generally considered 128.

 



meaning the shadows are blocked up). If the histogram falls just within the
left and the right end points, you have a very printable image. 

If the histogram suggests a problem, you may want to check your expo-
sure. We constantly review our histograms on every photo assignment and
make adjustments as necessary. This kind of exposure control  is invaluable
to serious photographers.

Exposure Modes
Professional cameras offer multiple exposure modes designed to help you
achieve the best-possible exposure in your images. These settings vary from
camera to camera, but the following are some of the most common (and
commonly used) options.

Manual Mode. Manual exposure is a nonautomatic mode of camera
operation where the photographer sets both the shutter speed and aperture.
This allows you to choose the shutter speed/aperture combination for the
lighting conditions present, while maintaining the desired depth of field
(controlled by the aperture) or action stopping/blurring (controlled by the
shutter speed). Up until the 1970s, manual exposure was the only exposure
mode on any camera. The manual exposure mode (usually signified with the
letter M) is still available on modern cameras and is a popular choice with
professional photographers.

Automatic Modes. Many professional cameras have automatic exposure
settings available to the photographer. These exposure choices generally

Professional cameras offer multiple exposure
modes designed to help you achieve the
best-possible exposure—whatever the sub-
ject or setting. Photograph below by Jacob
Jakuszeit. Facing page photographs by
Patrick Rice (top left and right), Barbara
Rice (middle left), Richard Frumkin (middle
right), and Dennis Orchard (bottom).

 





include full program mode, aperture priority, and shutter priority. In these
modes, the camera makes some or all of the decisions regarding the camera’s
exposure settings. 

In full program mode (usually signified with the letter P), the camera
decides what shutter speed and aperture are needed for the exposure of the
image. The program mode is correct in many cases.

In the aperture priority mode (usually signified with the letter A), the
photographer sets the aperture and the camera automatically sets the shut-
ter speed that will provide the correct exposure.

In the shutter priority mode (usually signified with the letter S), the pho-
tographer sets the shutter speed and the camera automatically selects the
aperture that will provide the correct exposure.

Additional Exposure Considerations
With digital, there are a few other decisions that must be made before shoot-
ing an image. Unlike with film, these aspects of the image capture can be
adjusted frame by frame, so decisions about them are typically made at the
time of exposure (rather than before the shoot when selecting what type of
file to load into the camera).
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Portrait photographers often encounter
numerous lighting situations in a single ses-
sion, making a mastery of exposure critical
to success. Photographs courtesy of Lisa
SmithStudios.com.



ISO. As discussed in chapter 1, the ISO setting determines how sensitive
to light the image sensor will be. If you are working in bright light, you can
select a lower setting to minimize noise. If you are working in more subdued
lighting, you can select a higher setting. This will allow you to use more
practical apertures and shutter speeds but will also produce more noise in the
final images. 

White Balance. All professional digital cameras give the photographer a
selection of lighting options for matching the color balance of the camera to
the light in the scene. This feature, called white balance, ensures that the
images recorded will feature the most accurate possible colors.

Most cameras also have an automatic white balance setting that can be
used as the default setting for any lighting situation. In the automatic white
balance mode, the camera’s sensor automatically chooses the best white bal-
ance setting for the lighting it detects. This works well in scenes with aver-
age colors and lighting, so it can be a huge time saver for the photographer
who has to work quickly.
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Using the correct white balance setting
when shooting your images is much more
efficient than trying to correct off-color
results after the shoot. Photograph courtesy
of Visualizations Photography.

 



Selecting the automatic white bal-
ance setting doesn’t necessarily guar-
antee a perfect color rendition in
every shooting scenario, however.
For example, if you take a picture of
the bride in her white gown standing
next to the groom in his black tuxe-
do, the automatic white balance
mode should provide you with a nice,
white gown. However, if one of the guests who is wearing a red dress stands
next to the bride, you will probably see a blue color cast in the bride’s white
gown. Even though you are taking the picture from the same spot, at virtu-
ally the same time of day, and under the exact same lighting conditions, the
camera may try to overcompensate for all of the red it is sensing and add too
much blue to the picture. In such a case, you may want to select one of the
alternate settings described below.

Besides the automatic white balance setting, the photographer can set the
camera to one of the specialized white balance settings—usually depicted in
symbols. The symbol of the sun is for bright, sunny days. The symbol show-
ing clouds is for cloudy, hazy, or overcast days. The symbol depicting a light-
bulb is for tungsten light. The symbol depicting a fluorescent bulb is for flu-
orescent light. The symbol showing a lightning bolt is for flash photography.
Some cameras show a symbol that depicts shade for subjects placed in shad-
ed areas of the scene. 

Many digital cameras also have a custom white balance setting where the
photographer can meter a white card (or any other pure white subject in the
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WALLACE EXPODISC
We use Wallace ExpoDisc’s digital white balance filter to set an accurate custom white
balance in tricky lighting conditions and ensure color fidelity in our images. To use it,
attach or hold the filter on the front of your lens, take a reading, and set the white bal-
ance. Because the ExpoDisc collects light from 180 degrees, it effectively averages light
from all the light sources in the scene. This leads to very accurate color renditions, so
taking a few seconds to use it seems like a much better option than spending exponen-
tially more time in the digital darkroom making hit-or-miss attempts at achieving color
fidelity. 

Using the correct white balance setting for
your light source, you can produce accurate
colors or intentially introduce a slight color
cast to slightly warm otherwise very cool
tones. Photograph by Debora Woodward.

 



identical lighting situation as the
intended subject) and use that
data as the standard for the scene’s
color balance. 

More advanced digital cameras
have a Kelvin (color temperature
degree) setting where the photog-
rapher can manually select the
exact color temperature for a par-
ticular scene using a color temper-
ature meter (see page 9).

At times, color fidelity is a must,
and using the proper white bal-
ance setting (or film) is essential.
In some instances, however, mis-
matching the white balance setting
and the light source can produce
desirable results. This is a practice
that our studio routinely employs
when photographing at the his-
toric Cuyahoga County Court-
house in Cleveland, Ohio. This
hundred-year-old building is con-
structed of primarily gray marble
on the inside. If you create pic-
tures using the electronic flash or
tungsten white balance settings,
the building is recorded exactly
the way we see it with our eyes:
gray and cold. When we use the

daylight white balance setting with the incandescent illumination in this
building, the resulting images are much warmer and more romantic. Our
brides and grooms love the look of the images made in this building and
wouldn’t want their images shot any other way.
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Here, weathered boards are rendered in
warm tones for an appealing portrait set-
ting. Photograph by Leonard Hill.

 



Light is the single most important component of any photograph—after
all, without light, there wouldn’t be a photograph. The importance of

light to photography is contained in the word itself, which literally means
writing (-graph) with light (photo-). In this chapter, we’ll examine some of
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4. LIGHT AND LIGHTING

Whether it’s natural or artificial, beautiful
lighting is critical to a top-quality image.
Photographs by Leonard Hill (left) and Bob
Kunesh (below).



the tools and techniques that are critical to achieving professional-quality
results.

Type of Light
Light can either be natural or artificial. Natural light is light that comes from
the sun, whether it’s the low light that filters into a shady area, the light
beams that filter through a window, or direct sunlight coming from a cloud-
less sky. Artificial light is light that comes from any other source. This cate-
gory includes but is not limited to household bulbs, televisions, neon signs,
a flashlight, or a string of patio lights. Photographers use both natural and
artificial light of all kinds when creating images, and often these sources are
used in combination to great effect. 

The Behavior of Light
When light, be it natural or artificial, strikes a surface, there are four options
for how it will behave; it can be transmitted, refracted, reflected, or ab-
sorbed. Understanding these options is critical to controlling light.

Light is transmitted when it passes through a substance without changing
direction—such as light coming through a window. 

Light is refracted when it passes through a substance and does change
direction. Refracted light rays are bent and slowed down (think of the light
through a prism, for example). 

Light is reflected when it bounces back off a surface. When light strikes
an uneven surface, the light is reflected in many different directions at the
same time. When light strikes a very smooth surface, it bounces back at a
predictable angle in a predictable direction; the angle of incidence (the angle
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SPECTRUM OF LIGHT
Light is often described according to its
wavelength as measured in nanometers
(nm). The visible spectrum of light is
from 400nm to 700nm. Light wave-
lengths shorter than 400nm fall into
the ultraviolet range. Light wavelengths
longer than 700nm fall into the infrared
range.

 



at which the light hits the surface) equals the angle of reflectance (the angle
at which the light is bounced off the surface). Some surfaces, like mirrors,
are such efficient reflectors that they bounce back all of the light that hits
them. 

When light is neither reflected nor transmitted, it is said to be absorbed.
This is why black material (thick felt or velvet, for example) is often used for
some backgrounds; it absorbs almost all the light that falls on it and creates
a simple background with no detail.

Most subjects and surfaces reflect some of the light that strikes them and
absorb the rest. This is how different colors and tones are created. For exam-
ple, when light strikes a red apple, the red elements of the light are reflect-
ed back to our eyes, while the other parts of the light are absorbed. As a
result, we see the apple as red. When light strikes the pages of this book, the
text absorbs almost all the light so it looks black. The page around the text
reflects almost all the light, so it looks white. 

Characteristics of Light
Light is described according to the effect it has on a subject or scene. The
terms and concepts that follow apply to both natural and artificial light.

Direction. One of the most important qualities of the light from any
given source is its direction. This determines where highlights and shadows,
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In the studio, light can be precisely sculpt-
ed to create flawless portraits. Photographs
by Leonard Hill.

 



the tonalities that produce the look of a third dimension in photography, will
be created on the subject. As you will see, the direction of light is usually
described in relation to the subject, so moving either the light source or the
subject can result in a change in the direction of the light. By changing the
camera’s perspective, you may also include more or less of the shadows and
highlights created by the light. 

In most cases, a light source illuminates the side of the subject closest to
it and leaves its opposite side in shadow. When extremely diffuse light (see
below) is used, however, the scene sometimes lacks shadow. 

Light coming from in front of the subject is called front lighting. With
this type of lighting, the detail in the front of the subject is well illuminated.
As there may be only minimal shadow areas, however, the image may lack a
dimensionality and texture. This type of lighting is used in many fashion and
glamour portraits because it creates a smooth, flawless look on the skin.

Back lighting is light that comes from behind the subject and toward the
camera. This type of light often leaves the front of your subject in shadow or
underexposed in the final image. It can also cause the edges of a subject to
appear lit (or even to seem to glow). When this effect occurs with backlight-
ing, it is often called rim lighting.
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The direction of the light is sometimes very
obvious (left) and sometimes much more
subtle (right). Photographs by Chris Nelson
(left) and Patrick Rice (right).

BOUNCE LIGHT
Bounce light is light that does not
travel directly from the source light but
first bounces or reflects off something
before reaching the subject.

 



Side lighting, as you might suspect, originates at some angle to the left or
right of the subject. This type of lighting can result in more pronounced
shadows. As a result, it is common in portrait photography, where showing
the shape of the subject’s face is important to the image. 

Hard or Soft. While the direction of the light determines where on a
subject the highlights and shadows will fall, the quality of the light will deter-
mine how soft or well defined these shadows are. Based on this, light is
described as either hard or soft. Hard light, like the light available outdoors
on a bright, sunny day, produces dark, hard-edged shadows, bright colors,
and bright highlights. Soft light, like that from an overcast sky, produces
paler, softer shadows, or no shadows at all. The colors of objects illuminat-
ed with soft light also tend to be more subdued, or muted. For most images,
soft light is the photographic ideal. While soft light is not always readily
available in a given scene, hard light can be modified and made softer
through the use of light modifiers. This will be covered later in this chapter.

Whether a light source is soft or hard is determined by the size of the light
in relation to the subject. 

Hard light is produced by sources that are small in relation to the subject.
For example, think of the crisp, well-defined shadows that appear on a
bright, sunny day. Of course, the sun is an immense source of light, but be-
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Hard light forms deep, well-defined shadows
that are perfect for this dramatic portrait of
a strong young woman (left). Soft light
forms lighter, more gentle shadows that suit
this subject’s warm smile (right). Photo-
graphs by James Williams (left) and Leonard
Hill (right).

 



cause it is so far away, that one tiny dot of light in the sky is actually very
small in relation to the subjects it illuminates here on Earth.

Soft light is produced by sources that are large in relation to the subject.
Taking the example of the sun again, imagine that you are standing outside
on a very overcast day. If you can see your shadow at all, it will be very pale
and not very well defined (i.e., the edges will be soft and fuzzy). This is
because the clouds overhead have broken up the light and scattered it across
the sky. On a day like this, the entire sky is the light source—and it’s huge!
As a result, the light is soft.

When we consider artificial light, the same principles apply. If you light
your subject with a relatively small source (say, a bare bulb), the light will be
hard. If you move that bulb closer to the subject, the light will become soft-
er. You can also soften the light by adding something between the source
and the subject to diffuse the light. This could be a professional light mod-
ifier (like a softbox [see page 74]) or something as simple as a large white
sheet held up between the subject and the light.

Conversely, if you are using a large light source (say, a large window) but
don’t see the crisp shadows you want, you could move your subject farther
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Most clients prefer soft lighting for portraits
of babies and children. Photograph by Pat-
rick Rice.

 



away from the window. This will make the window smaller in relation to the
subject and, therefore, the light will become harder.

Natural Light
Natural light can be used to create many appealing effects, especially in por-
trait photography. While studio lighting offers the ultimate in control, many
photographers still prefer the simplicity of working with natural light. 

Keep in mind that, because your light sources are fixed when using natu-
ral light, you will control the effects you achieve primarily by adjusting the
position of your subject in relation to the light. You can also control the light
by blocking it from above or the side (using a gobo; see page 76) or by
bouncing light into a shadow area (using a reflector; see page 76).

Overhead Light. When working with sunlight, it is best to avoid situa-
tions where the light strikes the subject from above. This can create unpleas-
ant shadows on the face. This can be avoided by shooting early or late in the
day, when the sun is naturally at a low angle (see below). Or, you can look
for situations where the light is diffused and, if possible, blocked from over-
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THE INVERSE SQUARE LAW
The Inverse Square Law states that the
intensity of illumination is inversely pro-
portional to the square of the distance
between the light and the subject. This
means that if the distance between the
light and the subject is doubled, the
amount of light reaching the subject will
only be half of what it originally was. 

When shooting portraits outdoors, look for
situations where the overhead light is mini-
mized. Photograph by Barbara Rice.

 



head. The light at the edge of a clearing (with tall trees or branches over-
head) is often ideal, as is the light on a porch.

Window Light. You can also use natural light indoors. Window light (or
light through open doors) is often extremely flattering for portraits. Because
windows tend to be large, the light is typically very soft. Windows, by their
very nature, also produce light with good directional characteristics. If the
light entering the window is too harsh, you can add a reflector on the shad-
ow side of the subject to soften the shadows. 

Golden Hour. When working outdoors, photographers often prefer to
take advantage of the golden hour, a time when the sun is low in the sky and
produces side and back lighting. The general rule is that the best light occurs
from sunrise to one hour after sunrise and from one hour prior to sunset
until sunset. Of course, light can be used throughout the day when the sky
is overcast, the photographer is shooting in open shade, or the light is mod-
ified to produce softer light. When light is undiffused and directly overhead
(e.g., midday sun), bright highlights and unflattering, hard shadows result.

Flash
On-camera flash provides a simple source of illumination for situations
where there is very little natural light or where the natural light needs to be
enhanced. 
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Just after sunrise and just before sunset,
the sun is at a low angle and has a golden
glow that makes it ideal for portrait photog-
raphy. Photographs by Chris Nelson (left)
and Debora Woodward (right).

 



Built-in Flash. Many inexpensive
cameras and some professional models
have a built-in flash. This is either part
of the camera assembly or it “pops up”
when activated. Often referred to as
“wink light” flashes, these units pro-
vide flash illumination on subjects that
are fairly close to the camera (generally
within 15 feet). These low-powered
flash units do a very good job, but
because the flash is so close to the cam-
era lens, it is highly likely that you will
get red-eye when taking pictures of
people. Red-eye is a situation where the
light from the flash illuminates the area
in the back of the eye. Since the pupil
of the eye is actually a hole, light can
pass through all the way to the back.
The red color that is recorded is the
blood vessels just behind the eyeball. (This problem is not encountered
when using accessory flash units as described on the next page.)
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HIGH KEY AND LOW KEY PHOTOGRAPHY
When the overall tones in a scene are very light, the scene can be described as high
key. When the overall tones in a scene are darker, the scene can be described as low
key.  

In high key photography, the overall brightness of the scene is typically at least 2
stops brighter than middle gray. In professional photography, the term “high key” gen-
erally refers to photographing a subject against a white background. In addition, many
high key photographs feature white props and subjects dressed in white clothes. When
everything in the scene is white or very light in tone, the skin tones of the subject
command the viewer’s attention, as this is the darkest part of the scene and the area
of greatest contrast. This contrast reinforces the visual importance of the subject. 

Low key imaging has been around for centuries. The paintings of many of the great-
est artists of all time were low key works of art. These painters worked in low key
because their subjects wore darker clothing, and many portraits were illuminated by
candlelight or oil lamps. In low key photography, your background and subject’s cloth-
ing should be no brighter than middle gray and preferably darker. While black is a good
choice for a low key background, it does not mean that low key backgrounds cannot
have patterns or scenes in them. Low key portraits tend to have a rich and warm feel
to them, where high key portraits tend to be more open or airy. The relative light tones
of the subject’s skin against the dark surroundings attracts the viewer and reinforces
the importance of the portrait subject.

Mastering studio flash techniques opens up
a world of creative lighting possibilities.
Photograph by Rob Ledwedge.

 



On-Camera Flash. For better results, many photographers prefer to use
on-camera flash. These are produced by camera manufacturers as well as
third-party manufacturers like Metz and Quantum. 

This type of flash is connected to the camera through the hot shoe or via
a sync cord. The units can be mounted directly on the camera, held by the
photographer at a position off the camera, or mounted above or to the side
of the camera using a flash bracket.

These flash units may be completely manual or fully automatic. Manual
flash units emit the same amount of light every time they are triggered.
Some have a variable power control setting. A flash meter is helpful with
these units so that you can accurately measure the light output and set your
camera accordingly. In the automatic modes, the camera communicates with
the flash and tells it how much light to emit for a proper exposure. This is
accomplished using TTL (through the lens) metering technology.

Studio Lighting
When the ultimate in control and precision is required, professional photog-
raphers rely on studio lighting. 

The following provides an overview of the terms and techniques you
should be familiar with. For a more detailed look at this enormous topic,
consult Master Lighting Guide for Portrait Photographers by Christopher
Grey (Amherst Media, 2004).
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Strobe lighting is a mainstay of studio pho-
tography. Photograph by Patrick Rice.

 



Strobes. Studio strobe lights (also known as electronic studio flashes) are
the favored light source for most studio photographers. They run cool, are
portable, and pair easily with daylight film (or the daylight white balance set-
ting). There are two types of studio strobes available: monolights and power
pack units. With either type, your camera communicates with the light units
via a sync cord or slave unit (this will be discussed in greater detail below).

Monolights. A monolight is a self-contained light that has both the power
supply and the flash head built into one complete unit. Monolights are AC
powered and can usually be triggered by direct connection to the camera’s
flash sync, or via a slave unit that allows the strobe to be triggered remotely
(i.e., without a direct physical connection to the camera). Many monolights
have a built-in slave unit that will fire the flash automatically when another
strobe is triggered in the studio. Separate radio slave units such as the
PocketWizard or Quantum radio slaves can also be connected to the mono-
light and the camera to trigger the light. 

Power Packs. Power pack lighting units can accept multiple flash heads,
which can be adjusted independently. Studio power pack units can be either
AC or DC powered. Some units will also operate on DC voltage with a car
battery. This can be handy on location when you want the flexibility of a stu-
dio light system but cannot plug into an AC power source. 
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Strobe lighting runs cool, making the shoot
more compfortable for your subject. Photo-
graph by Patrick Rice.

 



Modeling Light. When triggered by the camera’s shutter button, strobes
emit a “pop” of light. Obviously, working with only this momentary burst
of light would make it very difficult to place your lights in relation to the
subject. Therefore, strobe units also house a modeling light, typically a 250-
watt tungsten halogen bulb. This light stays on continuously to help you
focus your light and see how it illuminates your subject. (Some modeling
lights turn off after the strobe is fired then turn on again when the flash has
recycled and is ready for use in the next shot.)

Continuous Light. Before the invention of strobe lighting, continuous
light sources were the only option for studio photographers. Today they are
experiencing a renewed popularity. Continuous sources have one main
advantage over instantaneous ones: you see exactly the lighting effect you
will get, because the light source is both the modeling light and the actual
shooting light. There is also more light available for focusing with these
sources. Additionally, since the advent of digital imaging, balancing your
recording medium to the color temperature of these lights is very simple
(simply set your camera’s white balance appropriately, using a custom setting
if needed).
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In studio situations, the modeling light
allows you to preview your light so the posi-
tion will be just right. Photograph by James
Williams.

 



Tungsten Lights. Tungsten lights for
photography are like supercharged ver-
sions of regular household lights. They
are available from 100 watts all the way
up to 24,000 watts. Shooting with
these lights requires adjusting your
camera’s white balance setting to tung-
sten, or using a tungsten-balanced film.

HMI Lights (Halide Metal Iodide). HMIs take a short time to warm up
and require a ballast. However, they are very bright and daylight balanced.
These units tend to be very expensive.

Fluorescents. Professional photographic fluorescents, unlike tungsten
lights, run very cool, which can help keep your subject more comfortable.
They can be either daylight or tungsten balanced, but tend to be limited in
the intensity of their illumination.

Light Modifiers. A light modifier is a device used to control the direc-
tion, focus, and quality of light of your light source. These modifiers can
generally be used with either strobe or continuous light sources. Below is a
description of the more common ones.

Barebulb Flash. The first “modifier” is actually the removal of all modifiers.
On certain portable strobe units, the flash can be fired in the barebulb mode.
To use a flash in the barebulb mode, simply remove the reflector to expose
the flash tube. The barebulb flash emits light in 360 degrees, providing an
even and natural-looking form of illumination. This is great for opening up
shadow areas in a portrait and providing nice clean highlights. Some pho-
tographers even use a barebulb flash behind the subject to serve as both a
backlight and background light. It is an easy and inexpensive way to provide
a separation light and open up the background all at the same time. 
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LIGHT PAINTING
Light painting is a technique where the photographer places the camera on a tripod
and sets a long exposure then moves around the subject with a light source. Light
painting can be achieved with any light source at all. A flashlight or modeling lamp
from a strobe can be used to “paint” light onto the subject. More commonly, photog-
raphers use light painting by firing a portable strobe at and around a subject several
times to give proper exposure to the final image.

Larger groups typically require larger light
modifiers and/or multiple sources to ensure
even lighting. Photograph courtesy of Visu-
alizations Photography.

 



For portable flash equipment that does not have barebulb capability, you
can create a variation of this type of illumination with a product called the
Gary Fong Lightsphere. The lightsphere is a plastic bowl-shaped reflector
with an optional dome lid. It is lightweight, easy to install and remove, and
eliminates the need for a flash bracket on your camera. 

Parabolic Reflectors. These bowl-shaped reflectors are the simplest type of
modifier. They simply surround the lamp and direct its light onto your sub-
ject. Some bulbs are painted with a silver coating that eliminates the need for
this reflector. These reflectors come in different sizes and with different fin-
ishes on the interior surfaces, allowing you to vary the effects produced. 

Parabolics produce light that is bright in the center then falls off gradual-
ly toward the edges. As a result, most portrait photographers prefer to feath-
er the light from these sources, directing the bright center of the light past
the subject and allowing only the softer edge of the light to illuminate the
face. This produces a softer, more even, and more flattering look.
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Studio lighting gives photographers the
highest-possible degree of control. Photo-
graph by Penney Adams.

 



Barndoors. Barndoors are a set (or two sets) of black panels that are
attached to the front of a light source and can be angled toward or away
from the light to both direct light to exactly where you want it to strike and
to keep stray light away from the camera lens, much like a lens hood. 

Snoots. A snoot is a long tube that is attached to the front of a light source
to create a narrow beam of illumination. It is used to highlight specific areas
of the subject or scene.

Softboxes. A softbox, essentially a large, fabric housing for the light source,
is often the light source of choice when photographers want to produce a
wide, diffuse quality of light. Softboxes come in a wide variety of sizes and
can feature a range of interiors that affect the quality of the light that is pro-
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Lighting can also be used to add color and
even a pattern to your background. Photo-
graphs by Barbara Rice (left) and Patrick
Rice (right).

 



duced. The front diffusion panel can be flat or contain baffles to spread out
the light or focus it more forward. Some softboxes feature a second, remov-
able diffusion panel for enhanced diffusion and even softer light. 

Umbrellas. As its name suggests, this is an umbrella-shaped modifier. Like
the softbox, the umbrella produces a wider, more diffuse quality of light. 

When using most umbrellas, the light head is pointed away from the sub-
ject and into the concave side of the umbrella. The interior of the umbrella
then bounces a broad beam of light back toward the subject. Photographers
may choose between umbrellas with white interiors (for white light), silver
interiors (for cooler coloration), or gold reflective material for warmer tones
in the image.
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Some umbrellas, called shoot-through umbrellas, are positioned with 
the light head pointing toward the subject and through the umbrella, which
is made of a translucent material. These umbrellas work very much like 
softboxes.

Lighting Accessories. In addition to light modifiers, there are a number
of other lighting accessories that can be used to enhance your lighting
effects.

Reflectors. Another way to add light to a subject is through the use of a
panel called a reflector. Reflectors bounce (reflect) the illumination from a
light source in another direction to add light where it is needed. Many stu-
dios use reflectors to add light to the shadow side of the subject. 

Reflectors can be white, silver, or gold. White reflectors reflect the light
back as white light. Silver reflectors act the same way that a white reflector
does, but since the silver is a more reflective substance, they bounce more
light back than a white reflector would. Gold reflectors are used to bounce
a golden or warm light back onto the subject. This golden light will “warm
up” a subject and give a warmer overall tone to the image.

Gobos. A gobo is a light modifier that is placed between the light source
and the subject. This prevents light from reaching a particular area (or at
least reduces the light on that area). This technique is also referred to as sub-
tractive lighting. 

Cookies. A “cookie” is a piece of opaque material with a pattern cut into
it that is placed in front of a light source to project a dappled lighting effect
on the subject or background. When the cookie is placed close to the light
source, soft shadows are produced; when the cookie is positioned farther
from the light source, more defined shadows result.

Gels. Gels are sheets of heat-resistant transparent material that are attached
to the front of a light source to change its color. 

Warming gels are particularly useful in portraiture, as they can add a gold-
en hue to skin tones. The most popular gel for this application is the CTO
(Color Temperature Orange) gel. These gels are available in a variety of
strengths, and the particular strength that best suits your
needs will vary from one subject to the next.

Gels can be employed to add color to a backdrop,
making it more vibrant or better suited to your subject’s
clothing, for instance. They are also used to balance one light source to
another. For instance, when using window light and tungsten light, the
tungsten light could be fitted with a gel to eliminate its normal yellowish
cast, making it a daylight-balanced source to match the light from the 
window.

Contrast and Light Ratios
Contrast. A highlight is a very bright spot in a scene, print, or transparen-
cy. Shadow is the area of a scene that is opposite the highlight where less
light is striking or is out of range of the light source. The difference between
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Warming gels are useful in portraiture, 

as they can add a golden hue to skin tones.

 



the light areas and shadow areas in a scene is defined as the contrast in the
scene. Contrast can be controlled when shooting the image as well as when
printing it or editing it.

Shooting. Lights produce highlights (bright areas), shadows (dark areas),
and midtones (areas of medium brightness). When the light source is very
hard, the difference between the highlight and shadow areas is great, provid-
ing a very high-contrast scene. When the light source is very soft, the differ-
ence between highlight and shadow is much less, and the result is a lower-
contrast scene. By controlling the quality of the light, therefore, you can
control the contrast in the image you are creating.

Printing. Contrast can be controlled in the traditional printing process by
choosing to use a high-, medium-, or low-contrast paper to print onto. This
is a particular advantage when it was not possible to achieve the desired over-
all contrast when the photograph was created.

Editing. Contrast can also be controlled through the use of programs
such as Photoshop. Photoshop allows you to adjust the contrast in a digital
file using Levels, Curves, Brightness/Contrast, and several other functions.
Each of these tools gives you a different way to approach the contrast in an
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Contrast can be controlled while shooting,
in printing, or during the image-editing pro-
cess. Photographs by Patrick Rice.

 



image and allows the photographer to choose the one that will best suit the
particular image.

Light Ratios. Similarly, in portrait photography, the term “light ratio” is
used to describe a comparison of the illumination levels on either side of the
subject’s face. It can be said that the light ratio determines how much con-
trast you give to the lighting of the subject. 

If the illumination on one side of the face is the same as the illumination
on the other side of the face, the light ratio is said to be 1:1. If the illumina-
tion on one side of the face is twice as bright as that on the other side of the
face, the light ratio is said to be 2:1. 

To determine light ratios in a studio situation, photographers use a flash
meter to measure the illumination emitted from their strobes. In other set-
tings, light meter readings from the highlight (more illuminated) and shad-
ow (less illuminated) sides of the face can be compared to determine the
ratio.

Portrait Lighting Basics
Lights. While effective lighting setups can be created with just one light (the
main light), other subjects call for two lights (the main light and fill light),
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The light ratio in a portrait is used to
describe the difference in light intensity
between the shadow side of the face and
highlight side of the face. With low ratios,
both sides of the face may be almost equal-
ly illuminated (left). With higher ratios, one
side of the face will be decidedly darker than
the other (right). Photographs by Dennis
Orchard.

 



or perhaps several lights—and light modifiers. We’ll take a look at the role
of these main players before moving to a discussion about portrait lighting
styles.

Main Light. The main light (also called the key light) is the principle light
used to form highlights and shadows, creating form and the appearance of a
third dimension in the two-dimensional image. Outdoors, the main light
source may be the sun. Indoors, the main light may be a strobe or other arti-
ficial light source. In most cases, the main light is placed in front of the sub-
ject and at least a little to the side. 

Fill Light. The fill light is the second most important light in any given
lighting setup. Its job is to lighten the shadows created by the main light. To
do this, the photographer typically places the fill light close to the camera so
the shadows the light creates fall behind the subject and are less visible to the
camera. Reflectors are popular fill light sources because their effects can be
instantly previewed and adjusted. As a general rule, if important shadow
areas of your subject are much darker than the highlight areas, you should
consider adding fill light.

Hair Light. A hair light is employed to add highlights on the subject’s hair
and not much else. Hair lights are generally
lower-powered lights used with a snoot to
direct the light only onto the subject’s hair. 

Kicker Light. Kicker lights (also called
accent lights) are used to add illumination to
particular areas of a photograph where the
photographer wants to draw the viewer’s
attention. Kicker lights are usually smaller
lights used to brighten or “open up” areas of
the portrait. 

Background Light. A background light 
is used to ensure that the background of 
an image is properly exposed and to create
separation between the subject and the back-
ground. This is usually placed directly behind
the subject and pointed directly at the back-
drop, or to the side and skimmed across the
backdrop.

Basic Portrait Types. There are two basic
types of portrait lighting. These are deter-
mined by the angle at which the subject’s
face is photographed and the side of the sub-
ject on which the main light is placed.

Broad Lighting. Broad lighting is a type of
portrait lighting where the main light source
illuminates the side of the face turned most
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CATCHLIGHTS
A catchlight is the specular highlight, or
reflection of the light source, that
appears in the iris or pupil of the sub-
ject’s eyes. A single catchlight in each
eye is preferred to the appearance of two
catchlights, which can sometimes result
when a fill light is added to the lighting
setup. Two catchlights can create the
impression of a blank stare. Extra catch-
lights can often be digitally retouched
out of the portrait.

Placed above the subject, a hairlight adds
shine to your subject’s hair. Photograph by
Leonard Hill.

 



toward the camera. It tends to flatten the contours of the face and produces
a wider view of the face. Therefore, it is used less often than short lighting.

Short Lighting. Short lighting is a type of portrait lighting where the main
light illuminates the side of the face that is turned away from the camera.
Short lighting is often used to make a person with a wide face appear thin-
ner. When used with a weak fill light, this setup can produce portraits with
strong highlights and dramatic shadows.

Lighting Styles. Most portrait photographers aim to produce one of the
following portrait lighting styles when creating their portraits.

Flat Lighting. Flat lighting is a type of lighting that lights both sides of
the face evenly. Flat lighting is created by having a single light source
attached to the camera or directly above the camera. On-camera flash creates
flat lighting on a subject. 

Butterfly Lighting. Butterfly lighting, also known as Paramount lighting,
is a feminine lighting style that produces a butterfly-like shadow beneath the
subject’s nose. The lighting style emphasizes smooth skin and high cheek-
bones. To produce this lighting style, the main light is positioned high and
directly in front of the subject. The fill light is placed directly beneath the
main light, at the subject’s head height. Next, the hair light is placed above
and behind the subject, opposite the main light. (Care should be taken to
ensure that it lights only the hair and does not skim across the subject’s face.)
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With broad lighting, the main light falls on
the side of the face that is turned most
toward the camera (left). With short light-
ing, the main light falls on the side of the
face that is least visible to the camera
(right). Photographs by Bernard Gratz (left)
and Ken Holida (right).

 



Finally, the background light is placed low and behind the subject to form a
semicircle of light behind the subject that fades out toward the edges.

Loop Lighting. Loop lighting is a variation of butterfly lighting and is flat-
tering for people with oval-shaped faces. To create this style of lighting, place
the main light lower and a bit more to the side of the subject so that the
shadow under the nose becomes a small loop on the side of the face. The fill
light should be placed on the opposite side of the camera, across from the
main light, and close to the camera/subject axis. It’s important to ensure
that the fill light does not cast a shadow on the subject. The hair light and
background light should be placed as described for butterfly lighting. 

Rembrandt Lighting. Also called 45-degree lighting, this portrait lighting
style is characterized by its small, triangular highlight on the shadowed cheek
of the subject. This is a dramatic lighting style that is often used when pho-
tographing male subjects.

To create this lighting style, place the main light lower and farther to the
right than is described in the styles outlined above. Position the hair light as
described in the loop lighting description, but move it in a bit closer to pro-
duce stronger highlights in the hair. The background light should also be
placed as described above. However, the kicker lights should be positioned
to add brilliant highlights to the outline of the face and shoulders. (Note: It
is important to ensure that these lights do not shine into the lens.)

Split Lighting. The term split lighting is used to describe a lighting style
in which the main light illuminates only half of the face. It’s a dramatic light-
ing style that can be used to narrow wide faces or wide features and can be
softened slightly when a weak fill is introduced.

To create this lighting style, move the main light lower and farther to the
side of the subject than it is used in the other lighting style descriptions.
Sometimes, the light may even be placed slightly behind the subject. This
placement may be necessary when the subject is turned far from the camera.
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Butterfly lighting (left) creates gentle, even
lighting that emphasizes smooth skin and
high cheekbones. Photograph by Leonard
Hill.

In loop lighting (center), the shadow under
the nose becomes a small loop on the side
of the face. Photograph by Rob Ledwedge.

In Rembrandt lighting (right), a characteris-
tic triangle of light appears on the subject’s
shadow-side cheek. Photograph by Rick
Ferro.



Profile Lighting. Also referred to as rim lighting, this dramatic lighting
style is used to emphasize a subject’s elegant features. In this portrait style,
the subject is turned 90 degrees from the lens. The main light is placed
behind the subject to illuminate the center of the profile while highlighting
the edge of the face, as well as the hair and neck. The fill light is positioned
on the same side of the subject as the main light, and a reflector is added
opposite the main light to fill in the shadows. The background light is placed
as described earlier. In this setup, the addition of a hair light is optional, but
it can be used on the reflector side of the subject for enhanced tonal separa-
tion from the background.
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In this profile portrait, the light is in front
of and slightly behind the subject. This
highlights the shape of the profile while
allowing much of the rest of the figure to
fall into shadow. Photograph by James
Williams.

 



Photographic filters are devices that are placed in front of the camera lens
to, in some way, transform the light that enters the lens before it hits the

film or image sensor. Software filters are programs that are designed, in some
cases, to mimic the effects of photographic filters, and in other cases to pro-
vide other creative effects. The following overview will provide you with a
working knowledge of filters and their more common applications. For a
complete, detailed study of filters, you may wish to consult Professional Filter
Techniques for Digital Photographers by Stan Sholik (Amherst Media, 2007). 

Photographic Filter Basics
You may find that some types of photographic filters better suit your photo-
graphic specialty than others. Many portrait photographers rely on a selec-
tion of softening and diffusion filters and warming filters. Photographers
who specialize in landscape and nature photography often carry skylight,

polarizing, and close-up filters in their camera bags.
Materials. Filters are made from four materials: gela-

tin, polyester, resin, and glass. Each type has its own ad-
vantages and disadvantages. For all filters, keep in mind

that anything you place between your lens and the subject introduces the
possibility of image degradation. Therefore, it pays to invest in high-quality,
professional-grade filters if you are looking for the best-possible results.

Gelatin. Gelatin filters are the most widely available but also the most del-
icate. Because of their precise manufacturing, they are the least likely to de-
grade image quality.

Polyester. These filters, which are much more durable, are rapidly replac-
ing gelatin filters. They are available in a range of types and are reasonably
priced.

Resin. Unlike gelatin and polyester filters, resin filters don’t need to be
one solid color—they can have gradations of color and many other charac-
teristics. They are lightweight and durable.

Glass. Like lenses, better glass filters have antireflection coatings that min-
imize degradation. Some also include an anti-scratch coating for added dura-
bility. This makes them a good choice for filters you will leave on your cam-
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5. FILTERS

Many portrait photographers rely on a 

selection of diffusion and warming filters.

 



era all the time, such as a UV (ultraviolet reducing) or skylight (ultraviolet
reducing and warming) filter (see below). 

Types. There are two types of filters: those that attach to the lens of the
camera with a screw mount and those that drop into a filter holder attached
to the front of the camera. If you own a limited number of lenses that all
take the same size filter or if you plan on just using one type of filter, then
screw-in filters are the way to go. These are durable and convenient. For
most people, however, the flexibility of a drop-in system makes it the best
choice.

Filter Factors. Many filters work by absorbing a portion of the visible
spectrum of light. Therefore, you must often increase your exposure when
using them. As a result, filters have “filter factor” numbers on them, telling
you how much the exposure should be increased to compensate for the loss
of light due to the use of the filter. A filter factor of 1 requires no exposure
adjustment, a filter factor of 2 requires a one-stop (1x) adjustment, and a fil-
ter factor of 4 requires a two-stop (2x) exposure increase. If you are using
your SLR’s built-in light meter to meter the scene through the lens, you
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Many photographers leave a UV or sunlight
filter on their camera at all times to protect
the front surface of the lens. This is espe-
cially a good idea when working outdoors or
on location. Photograph by Leonard Hill.

 



don’t need to worry about filter factors; the meter will account for the filter
in its reading.

Types of Photographic Filters
Lens Protection. There are two filters, the UV filter and the skylight (1A)
filter, that can be left on at all times to protect the lens from damage while
handling the camera. While the skylight filter has a slight warming effect on
the scene, the UV filter does not affect the color rendition of your final
image. 

Color Conversion. A color conversion filter is a color filter that is used
to convert the color temperature of the light entering the camera to match
a film or a digital camera’s white balance setting. These filters are generally
blue or amber in color. The blue filters are in the 80 series of filters, and the
amber filters are in the 85 series of filters. The blue series of filters raise the
color temperature by blocking warmer wavelengths of light, and the amber
series lowers the color temperature by blocking cooler wavelengths of light.

Color Compensating. Color compensating filters are used when you
want to increase or decrease the presence of a color in the scene. These fil-
ters are available in red, green, blue, cyan, magenta, and yellow (the primary
additive or subtractive colors). Photographers can choose filters in a 
variety of densities to impart both small and large changes to the image. The
color and strength of a color compensating filter is designated by CC/
density/color. For example, a CC20M filter is a magenta color compensat-
ing filter with a .20 density. Photographers commonly use color compensat-
ing filters to enhance the mood in a photograph. Other uses are to proper-
ly color balance a scene under fluorescent or mercury vapor illumination.

Infrared. Though it had its start in the scientific community, today
infrared imaging is used by professional photographers to create otherworld-
ly images that offer viewers an unexpected and pleasing view of the world

FILTERS 85

Infrared photography can create images
with an otherworldly look. Photograph by
Patrick Rice.

 



around them. Infrared “sees” things much differently than we do. Skin tones
tend to lighten and blemishes are reduced. Fabrics often render in unexpect-
ed tones (especially synthetic ones). Green foliage appears white, taking on
a dreamlike, snowy appearance that is one of the most aesthetically pleasing
reasons for infrared imaging. The blue sky may appear jet black and dotted
with bright white, glowing clouds. 

These images can be created either on film or digitally. Infrared film is
available from several manufacturers and each brand will produce its own
unique look. If you choose to shoot digitally, you will need to select a cam-
era that is sensitive to infrared light, or one that has been modified to be
made sensitive to infrared (for more on this, see my book Digital Infrared
Photography [Amherst Media, 2006]). There are many advantages to shoot-
ing digitally. First, because we cannot see infrared light, predicting its effects
is difficult. Therefore, being able to instantly review your images on the cam-
era’s LCD screen is invaluable. Additionally, infrared film is both expensive
and difficult to work with (it must be kept cold, and absolute darkness is
required when loading and unloading).

There are two primary types of filters used when creating infrared images:
the #25 red filter and the opaque filter. Both filters are used to reduce the
amount of visible light that reaches the film or image sensor, allowing the
infrared light to play a greater role in the exposure. The red filter blocks only
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In infrared, skin tones tend to lighten and
blemishes are reduced. Green foliage also
appears white, taking on a dreamlike
appearance. Photographs by Patrick Rice.

 



some of the visible light and produces a more subtle infrared look. Opaque
filters cut off all visible light and only allow the invisible infrared rays of light
to pass and strike the film/sensor. This produces a more dramatic infrared
look. 

Neutral Density. There are times when photographers may want to make
an exposure using a wider aperture or slower shutter speed than is possible
in the lighting scenario. In this case, neutral density filters, which uniformly
block all wavelengths of light, can be used to decrease the overall amount of
light reaching the film/sensor. These filters, available in a wide variety of
strengths, can make it possible to use the desired exposure settings. 

Polarizing. Polarizing filters block light waves that vibrate from particu-
lar angles to the lens in order to reduce reflections from nonmetallic surfaces
such as glass or water. Polarizing filters can also be used to darken skies and
intensify colors in a scene. There are two types of polarizing filters: linear and
circular. With modern digital SLRs, linear polarizing filters can interfere with
the camera’s metering and autofocus systems. Therefore, you should select
a circular polarizing filter if you use this type of camera.

Diffusion. Diffusion filters are designed to slightly blur the details in the
image. A slight soft-focus effect is often useful in portraits, as it helps to
downplay fine lines and wrinkles. Some filters in this category produce a soft-
ening across the entire image. Other types blur select portions of the image,
allowing for sharp focus in other image areas.

Close-up. Close-up filters are actually close-up lenses, since they don’t
affect the spectrum of light passing through them. These filters extend the
close-focusing distance of the lens to which they are attached. They come
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Diffusion, whether created digitally or with
traditional photographic filters, helps to
soften the skin and create more flattering
portraits. Photograph courtesy of Visuali-
zations Photography.

 



in a range of strengths from 0 to 10;
the higher the number, the greater
the magnification.

Digital Filters
Today, photographers can use both
photographic filters and digital filters
to enhance their images. This pro-
vides a greater degree of control than
ever before. 

Digital filters can be used to create
a wide range of effects. Some dupli-
cate those that can be created with
traditional filters. The effects of
warming filters and diffusion filters,
for example, are easily replicated
using the filters that come with
Adobe Photoshop and most other
image-editing programs. In fact, these software filters offer even more con-
trol, since you can precisely adjust the degree to which the effect is applied
and even apply it selectively to only parts of the image. Another advantage
of using digital filters is that most allow you to save the settings you like, so
you can apply them again and again to achieve the identical effect in a series
of images. You can even use batch processing and actions to quickly apply
filters to large groups of images.

Digital filters can also be used to create some effects that have no corre-
late in traditional photographic filters. Photoshop, for instance, includes fil-
ters that allow you to transform your images into pen and ink sketches,
watercolors, or even stained glass. You can also produce embossed looks,
solarization, or wave effects with the click of a button. These are looks that
would be difficult, if not impossible, to create using traditional photograph-
ic processes. For more on this type of filters, see chapter 5.

There are, on the other hand, some photographic filters that can’t be
replicated digitally. The effect of polarizing filters can, in part, be replicated
by filters that intensify colors and darken skies, but no digital filter can
instantly remove the reflections from water the way a photographic polariz-
ing filter can. While you can also enlarge your image digitally, Photoshop
does not take the place of close-up filters for shooting small subjects.

For most photographers, both traditional photographic filters and digital
filters play some role in their work. The best way to learn what filters best
suit your style is to do some experimenting with the wide range of options
available. 
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Digital filters allow photographers to cre-
ate looks that go far beyond the effects of
photographic filters. Photograph by Bob
Kunesh.

 



Composition is the effective arrangement of all of the visual elements that
fall within the frame of the final image. In this chapter, we’ll look at

some compositional strategies that will help you ensure a stronger, better-
crafted image.

Center of Interest
In creating your image, you want to have one and only one primary center
of interest. The main subject should be the thing that catches your eye. (The
exception to the rule is when you wish to emphasize the arrangement of
lines, shapes, and colors that make up an image, rather than a main subject.)
To accomplish this, you must ensure that the other compositional elements
within the four borders of your image lead the viewer’s eye back to your sub-
ject. They must never direct the viewer’s gaze out of the photograph or away
from the main subject. The following are two key elements to consider.

Contrast. Areas of high contrast attract the viewer’s eye and should be
evaluated carefully to ensure that they do not draw the viewer’s eyes away
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In the first image (left), the couple’s faces
are the lightest element in a dark frame, so
your eyes are immediately drawn to them.
In the second shot, the dark-toned subjects
stand out perfectly from the white back-
ground. Photographs by Rick Ferro (left) and
Leonard Hill (right).

 



from the subject. In a low key pho-
tograph the area of highest contrast
is the lightest part of the image. In a
high key photograph the area of
highest contrast is the darkest part of
the image. 

Consider, for example, a picture
of a bride in a white dress against a
solid background of dark green trees
and foliage. The bride in her light-
colored gown will, appropriately, be
the area of highest contrast and the
part of the image to which your eye
is drawn. Now imagine that there is
a bright sky area over the treetops—
suddenly the bride will compete for
attention in the frame. The same
thing happens when breaks in the
tress allow little bright spots of sky
to show through the foliage. Details
like these can destroy the impact of
an otherwise carefully composed
image.

Leading Lines. Leading lines
that draw your eye in toward the
subject(s) can greatly enhance the
composition of an image. Paths,
walkways, fence posts, etc., are lead-
ing lines that are often found in suc-
cessful photographs. Inside church-
es, the pews lead from both the left
and the right to the center of the
image where the subject is usually placed. The human eye naturally follows
lines toward where they lead. Understanding this and utilizing this tech-
nique will result in more effective photographs. 

In the Western world, we read from left to right. We subconsciously
“read” photographs in the same way. Therefore, leading lines that bring the
viewer from the left side of the image over to a main subject on the right can
greatly enhance the impact of the photograph. 

Subject Placement
Viewers typically regard more favorably those images where the main subject
is positioned off center. This type of composition creates a “flow,” a natural
arrangement of elements that draws your eye through the frame and toward
the main subject (never out of the frame or away from the main subject). 
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Notice how the fence (top) and pews
(above) lead your eyes right to the subject
of the image. Photograph by Bob Kunesh
(top) and Monte Zucker (above).

 



To create such an image, many photographers employ the Rule of Thirds
or Bakker’s Saddle (also called the Golden Triangle). 

Rule of Thirds. To compose an image according to the Rule of Thirds,
imagine that the frame is dissected by two horizontal and two vertical lines
(this should appear much like a tic-tac-toe board). Your main subject should
be placed in one of the points where these lines intersect. These points of
intersection are referred to as power points because they are natural centers
of visual attraction. By placing your subject at one of these power points,
your images will be more compositionally pleasing. For close-up portraits,
such as head shots, the main subject of your image (and the feature that
should be placed according to these rules) is the person’s eyes. For portraits
that show more of the body, the subject is the face as a whole. 

Because we read text from left to right, the strongest power point in the
image is generally the one at the lower right. Since the eye rests comfortably
here, many photographers place their subjects at this point. Your subject can,
however, be successfully placed at any of the intersections.
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This image, composed according to the Rule
of Thirds, shows a subject placed at the
lower-right power point. Photograph by Rick
Ferro.



Bakker’s Saddle. Bakker’s Saddle
is named for the outstanding pho-
tographer and instructor, Gerhard
Bakker. It is a compositional rule to
help photographers with the place-
ment of the main subject in their
images. The Bakker’s Saddle is creat-
ed by drawing a diagonal line from
the top-left corner of the image to
the bottom-right corner of the image. A 90-degree perpendicular line is then
drawn from that diagonal to the upper-right corner of the image. The main
subject of the photograph should rest in the “saddle” created by the inter-
section of two lines. It cradles the subject in a natural and harmonious way.

Centering. Centering your subject is usually considered a mistake. How-
ever, there are a few circumstances in which centering your subject create a
more powerful composition. First, centering is appropriate when the subject
is symmetrical. With a symmetrical subject, centering creates a bull’s-eye
effect that draws the viewer’s eyes right into the center of the image and
doesn’t let them go. Architectural studies that include a person or persons
should also be centered for proper balance. Centered compostions are also
preferred when the photographer utilizes a fisheye lens to create the image.
Because of the nearly 180-degree field of view of most fisheye lenses, the
subject looks best when placed in the middle of the composition.

Common Problems in Composition
Distracting Elements. In addition to placing the subject of your photo in a
powerful position in the frame, you can also improve your compositions by
eliminating distracting elements. Distracting elements are anything in a pho-
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THE SUBJECT’S GAZE
When your subject is not looking directly back at the camera, the viewer tends to follow
the subject’s eyes in the direction that they are looking. If the subject is looking to the
right side of the photograph, the viewer enters the image from the left of the subject and
then continues to follow the subject’s gaze out of the photograph. When we reverse or
flip the image, the subject is looking to the left side of the photograph. Now, the view-
ers enter the image from the left and travel up to the subject, but the subject’s gaze leads
them back to the left where they began; this presentation creates a visual “loop” that
encourages the viewer’s eyes to linger on the photo. 

Here, the subject’s eyes are placed at the
intersection of two lines drawn in Bakker’s
Saddle. Photograph by Leonard Hill.

 



tographic image that draws atten-
tion away from the main subject in
the photograph. 

Things that look unnatural or out
of place (e.g., telephone poles, high
tension wires, street signs, etc.) are
distracting elements. Objects that
are in a dramatically different color
or in a different key can be distract-
ing as well. In a low key (darker)
image, light colors and objects will
draw the viewer’s attention. If those
areas are not part of the main sub-
ject, they are distracting to the view-
er. In a high key (light) image, dark
areas do the same thing. 

Hotspots and light traps (bright
areas amidst dark tones) are common
distracting elements and should be
eliminated by retouching or cropped
out of the composition in order to
not distract from the main subject.

Crooked Horizons. It is impor-
tant that you maintain straight hori-
zon lines in your images. A crooked
horizon is distracting. This problem
is especially pronounced in scenes
that include the ocean in the back-
ground. If the horizon is crooked, it
looks like the water is going to pour
out of the photograph. 
A crooked horizon in a print can be

straightened by measuring from the
horizon line to the edge of the print

at both ends of the photograph and cutting the image down to the same
dimension from each end. After you have established the new straight hori-
zon line, simply trim the rest of the print back to a rectangle through the use
of a carpenter’s square, and you will have a print with a corrected horizon. 

In digital images, the horizon can be leveled by using Photoshop’s Crop
or Transform tools to carry out the steps outlined above.

Crooked Vertical Lines. Crooked vertical lines can be a distraction in
your images. They are caused by not shooting directly toward the vertical
subject, but rather shooting from a slight angle (either up or down). 

Some camera lenses are more likely than others to distort the vertical lines
in an image. Less expensive or inferior wide-angle lenses in particular tend
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The straight-on framing of the car, paired
with the subject’s symmetrical pose and
direct look, make this centered composition
very effective. Photograph by Ken Holida.

 



to create crooked verticals. Perspective control lenses can be employed to
eliminate these crooked verticals. These lenses work in the same way as a
view camera (see chapter 1). 

Sometimes it simply isn’t possible to keep your lens parallel with the ver-
tical lines in a scene. However, through software programs like Photoshop
(and some plug-ins for this program), you can now digitally fix crooked ver-
tical lines. 

Dividing Horizontal Lines. Successful prints usually do not have divid-
ing horizontal lines that cross directly through the center of the image. It is
important to try to place horizontal lines in either the lower third or upper
third of the finished print. This technique gives the print better balance and
keeps it from having a bisected appearance (i.e., looking as though there are
separate upper and lower images). In the compositional Rule of Thirds, we
place important subjects in one of the intersecting points of the tic-tac-toe
board that you can imagine sits atop every image. Any prominent horizon-
tal lines in the image should ride along either the top or bottom horizontal
line of that tic-tac-toe board.
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When the horizon appears in your image,
make sure that it is perfectly horizontal.
Photograph by Charlene Rule.

 



In addition, you should avoid composing images so that horizontal lines
divide or cut through your main subject. Instead, try to place the subject
under or considerably above any horizontal line in the image. When shoot-
ing, this can be achieved by changing your perspective in relation to the sub-
ject. As you lower your perspective (camera position), you will raise the sub-
ject up into the top of the image, far above the horizon line. As you raise
your perspective, you will lower the subject toward the bottom of the image,
thus composing them beneath the horizon line. Either option gives a more
visually pleasing appearance to your photograph.

Improving Composition After the Shoot
In the excitement or stress of the shoot, or just due to the realities of the
location or subject, it’s inevitable that not every composition will be perfect.
Fortunately, digital imaging gives us some recourse.

Cropping. Often, you can improve the image by cutting out any prob-
lem elements. Review each image  carefully and evaluate whether the com-
position supports your message about the subject and its relation to the
background against which you photographed it. Are there distracting ele-
ments that need to be removed? Are there leading lines that draw your eye
away from the subject? Is there dead space that contributes nothing to the
image? You may want to experiment with different ways of cropping out any
elements you feel need to be eliminated. 

Retouching. Sometimes, distractions in an image can’t be cropped out.
While retouching out problems can sometimes be time consuming, it may
be worth it to save a particularly good shot. Bright spots showing through
gaps in foliage are easy to eliminate using the Clone tool in Photoshop, as
are many other simple distractions (like light switches on a wall). Another
easily remedied compositional problem is crooked horizons, which can be
corrected in seconds using Photoshop’s Transform or Crop tools.
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When your image contains subjects in
motion, leaving some space in front of them
produces a more effective composition.
Here, the strolling subjects have plenty of
room to (in the viewer’s mind) meander
across the beach. If the same couple had
been composed at the far left of the frame,
they would appear to be walking right out of
the image! Photograph by Patrick Rice.

In architectural images, the sides of the
building should appear straight and perfect-
ly vertical. Photograph by Charlene Rule.

 



In most photographs, the posing of the subjects is vitally important. Many
times, a photographer will have a great-looking couple in a “fabulous

location” but will fail to pose them properly. As a result, the image will not
be successful (or at least not as successful as it might have been). For the
best-possible portraits, keep the following points in mind during every ses-
sion or shoot.

Start with the Subject
To be effective, a subject’s pose must be both believable and flattering. The
qualities that will contribute to this goal will depend on your subject. For
example, you would not pose a bride on her wedding day in the same way
as you would pose a football player in his uniform. Similarly, you would not
pose a woman in a formal evening gown in the same way that you would
pose her for a professional portrait to be used in her job as a police officer,
or in a beauty shot created for her husband. In each case, however, the qual-
ities you would seek when deciding on the pose would be the same; the pose
must be believable and flattering.

Comfort
One of the most important elements of any pose is the comfort of the sub-
ject. Unless you are photographing a professional model, an uncomfortable
pose will almost always result in your subject not looking his or her best.
Comfortable seating that allows for an upright posture, standing poses in
which the weight is on the back foot and the knees are slightly bent, and
some floor poses designed with the subject’s comfort in mind are all good
starting points for an effective pose.

The Head and Shoulders
Most professional photographers ensure that their subjects’ shoulders are
turned at an angle to the camera. Posing the client’s shoulders head-on to
the camera results in a static image that increases the apparent width of the
body. By creating angles in the portrait, we create a more flattering and
dynamic image. (There are exceptions to the rule: if your client is exception-
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A TRIANGULAR BASE
For the best results when composing a
head-and-shoulders portrait, have your
subject position their arms slightly
away from the sides of their body. This
creates a wider, more triangular base
for the portrait.

 



ally thin, or you wish to draw atten-
tion to their mass, as you would
when photographing a football play-
er, a square-to-the-camera presenta-
tion may be in order.)

Head Positions
We have already established that the
shoulders should be turned at an
angle to the camera for the most
flattering portraits. This forms the
desired base for any of the three
main head positions: the seven-
eighths view, the three-quarter view,
and the profile view.

Facial Views. The Seven-Eights
View. In this head position, the sub-
ject is looking just slightly away from
the camera. Although both of the
subject’s ears are visible in this posi-
tion, one side of the face is more
fully shown than the other.

The Three-Quarters View. In this
presentation, the far ear is not visi-
ble, and the side of the face closer to
the camera is significantly more visi-
ble than the far side of the face. This
presentation can make the eye far-
thest from the camera appear slight-
ly smaller. Therefore, pose your sub-
ject so that their smaller eye is closer
to the camera. 

The Profile View. To create this
pose, have your client turn his head
away from the camera until the far
eye and eyelashes are no longer visi-
ble from the camera position (about
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Often, the subject’s attire will help you
determine the best type of pose. For a
young woman in casual clothes, a relaxed
pose works well (top). For a subject in her
dance attire, something more graceful and
refined will fit the bill (bottom). Photo-
graphs by Chris Nelson.

 



90 degrees from the lens). This pose is often used to emphasize a subject’s
elegant features. 

Head Tilt. Also, tilting the subject’s head slightly, no matter the pose,
creates an implied diagonal line from one eye to the other. This simple
change can enhance every portrait. Traditionally, the female subject’s head is
tipped slightly toward the shoulder nearest the camera, and the male sub-
ject’s head is tipped slightly toward the far shoulder. However, this is not a
hard-and-fast rule. The overall appearance of the subject and the lighting
setup may dictate a different approach. 

Chin Height. Finally, be sure that your client’s chin is positioned neither
too low or too high, as one extreme can create an impression of haughtiness
and the other, a lack of self-esteem. 

Posing the Hands and Feet
Hands. Posing the hands can be a challenge. Because they are typically clos-
er to the camera than the subject’s face, they often appear bigger than nor-
mal. Using a slightly longer than normal lens can help to prevent this prob-
lem. It may be more difficult to achieve sharp focus on both the hands and
face with such a lens, but it is critical that the face is sharply focused; a slight
softening of the hands in the image is far less objectionable.

When posing the hands, it is a good idea to present them at an angle to
the camera, as a straight-on view can result in a distorted view of the hands
and fingers. It is better to present the side of the hand to the camera than to
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In the seven-eights view (left), the subject
is looking just slightly away from the cam-
era. Both of the subject’s ears are visible in
this position. In the three-quarters view
(right), the subject’s head is turned a bit
farther from the camera and the far ear is
not visible. Photographs by Leonard Hill
(left) and Rob Ledwedge (right).

BREAKING THE RULES
The rules described in this chapter have
historically been used to produce good
portraits and, as such, can be reliably
used for most every session. Once you
learn the rules, you’ll also develop a
sense of when a particular rule should
be broken. Sometimes, breaking the
rules can result in a portrait that sends
a unique and powerful message to the
viewer. 

 



show the back of the hand. The former view affords a more natural, flowing
line and discourages distortion. Additionally, be sure that the client’s fingers
are slightly separated. Otherwise, the hand may appear as a mass of skin
tones and may draw the viewer’s attention to the area. The wrist should be
slightly bent to ensure a more dynamic and relaxed presentation. 

Though rules can often be broken to good effect, it’s traditionally
thought that a man’s hands should exhibit strength in the portrait, and a
woman’s hands should appear graceful.

Feet. The perspective problem outlined above also applies to your sub-
ject’s feet. To avoid making the subject’s feet look shorter and wider, take
care to ensure that they are not pointed directly into the lens. For standing
poses, the client should avoid evenly distributing their weight on both feet.
With one foot slightly behind the other, their weight resting primarily on the
back foot, and the knee of their front leg slightly bent, the subject will be
more comfortable. 

While the feet may not be visible in the final portrait, correct positioning
will have a positive effect on the
overall pose. With a good foundation
for the pose, the client is more com-
fortable and will be better able to
remain in the finished pose.

Three-Quarter and 
Full-Length Poses
Three-Quarter Poses. When com-
posing a three-quarter pose, you
should take into consideration all the
guidelines for posing discussed this
far. Additionally, since more of the
body is visible to the viewer, some
thought must go into the posing of
these areas. 

The three-quarter view shows the
client from their head to somewhere
below the waist. It is best that the
bottom of the frame falls at about
midthigh or just below the knee.
Composing the image so that the
frame cuts through the knee (or any
other joint) tends to create an un-
settling impression. As mentioned
above, it is best to pose standing
clients with their weight on the foot
farthest from the camera, and a slight
bend in the front knee. 
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When they are visible in a portrait, the
hands are usually best seen in a side view.
Photograph by Rick Ferro.

 



In standing poses, avoid presenting the client with their arms simply
hanging at their sides. Men may be effectively posed with their arms folded
across their chest, with the hands in a side view as they gently grasp his
biceps. There should be a small space between his arms and chest, as this
provides a slightly slimmer, more flattering presentation. Women can be suc-
cessfully posed with one hand on their hip. The other arm should be very
slightly bent, with the wrist bent and a side view of the hand presented to
the camera. 

If the subject is seated, a cross-legged pose can be effective. Remember to
leave a slight space between the back of the leg and the chair to provide the
most slimming, flattering view. When posing a seated female client, it’s a
good idea to have the calf of the leg closest to the camera tucked slightly
behind the back leg. This reduces the apparent size of the legs.

Full-Length Poses. A full-length portrait, as the name implies, affords a
complete, head-to-toe view of the subject. As described above, each of the
areas of the body should be posed to present a flattering view of the subject.
Throughout this book you will find a variety of images that feature full-
length poses. Study these and use them to inspire your own work.

Group Portraits
All of the rules outlined in this chapter apply to posing the individuals in a
group portrait. The bottom line is, each subject in the group portrait should
look his best, and each pose should stand on its own to produce a composi-
tionally sound, attractive image.

When posing two or more people, you should seek to stagger the head
heights in the portrait. For instance, a tall man might be seated on a posing
stool with his fiancée standing by his side. If his eyes fall at a level that is
approximately even with her mouth, you have achieved a good height differ-
ential. On the other hand, extreme differences in height are to be avoided.
By slightly staggering the head heights, you can ensure that the viewer’s eyes
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When posing two or more people, you
should seek to stagger the head heights in
the portrait. Photographs by Mark Bohland
(left) and Michael Ayers (right).

 



will move easily from one subject’s face to the next, giving the portrait a
dynamic feel. 

When posing three or more clients, you should seek to create a uniform
distance between subjects, as leaving more space between one grouping than
another will detract from the cohesive feeling you are seeking to create. A
small corporate group might require more space than a tight-knit family
group, who might be positioned close enough together to touch. 

When photographing groups, the clothing choices are of special concern.
Many photographers suggest a uniform approach. For instance, a small cor-
porate group might wear their yellow polos shirts and khaki pants. A family
of four might be asked to wear dark jeans and white t-shirts for a cohesive
look. 

For more information on posing groups, see Group Portrait Photography
Handbook (2nd ed., Amherst Media, 2005) by Bill Hurter.

POSING 101

Group portraits don’t have to be stiff and
stuffy. Here, the natural poses and casual
(but coordinated) clothing make for a fun
portrait that’s full of life. Photograph by
Leonard Hill.

 



As experienced photographers know, the shoot is actually just the begin-
ning of the image-creation process. Especially in the digital age, most

photographers spend more time after the shoot retouching, enhancing,
archiving, proofing, and printing their images than they did creating the
shots in the first place. In this chapter, we’ll explore some of the critical steps
that take place after the shoot, beginning with techniques for perfecting your
images in Photoshop and wrapping up with a look at designing an efficient
digital workflow.

Photoshop Techniques
Color and Contrast Correction. While it would be nice if all the images we
captured contained exactly the colors and contrast we’d like to see, it’s just
not always the case. (The following information on color and contrast cor-
rection is excerpted from the book Color Correction and Enhancement with
Adobe® Photoshop® by Michelle Perkins [Amherst Media, 2004] and is used
with the author’s permission.)

The natural tendency when beginning to correct the color and contrast of
an image is to open it and start pressing buttons, clicking and dragging, etc.
Doing this, however, is sort of like taking a picture without bothering to
compose it—only once in a blue moon will you happen to achieve the best
results. As with most things, developing a good plan of action before diving
into an activity will minimize frustration and enhance
your odds of success.

Once you’ve opened your image in Photoshop, you
have two valuable tools at your disposal for evaluating it:
your eyes and the Eyedropper tool. Your eyes provide more subjective
results, while the Eyedropper tool provides results that are totally objective.
The Eyedropper tool samples colors, allowing you to see the color value of
pixels (displayed in the Info palette) as you evaluate an image. Moving this
over your image, you can use the readings in the Info palette to look for
problems in the following areas.

Evaluating Images. One common problem that can make both black &
white and color photos look less than perfect is the absence of a deep, rich
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As with most things, developing a good plan

of action will enhance your odds of success.

 



black and a bright, sparkling white. For most
images, achieving pleasing overall color
requires the use of the full range of possible
tones from black (or very near black) to white
(or very near white). Our eyes adjust to see this
full range of colors in almost every scene we
view around us, so if a photo lacks it we imme-
diately feel that the image looks flat or dull. So,
ask yourself: Are the darkest areas in this photo
dark enough? Are the lightest areas in this
photo light enough? Keep in mind, some im-
ages may have one problem or the other, some
may have both, and some may have no problem
at all in this area. 

If windows are the eyes to the soul of a per-
son, neutral tones are often the key to learning
what’s going on under the skin of a digital
image. If the neutral tones have a color cast,
chances are that the rest of the image does too.

A good place to start is with the whites.
Keep in mind, the whites you evaluate should
be areas of pure (or very close to pure) white—
like a catchlight, a cloud, a white bridal gown,
etc. Although we often refer to the “whites” of
the eyes or to people’s teeth as being white,
they rarely are. Once you’ve identified an area
to evaluate, examine it closely for any slight
shifts in color—what looks at first glance to be
white often turns out on closer inspection to be

faintly yellow, or blue, or pink. 
Like whites, grays that should be neutral in tone (not bluish gray or red-

dish gray) can reveal overall color casts. Here, the selection of an area to eval-
uate is much more subjective, though. Paved streets (in most areas) tend to
be a reasonably neutral gray. Sometimes clothes and other fabrics are neutral
gray (and this can be either light or dark). Shadows on white walls or back-
drops are also fairly neutral gray areas. 

If there are areas in your photo that you know should be neutral gray (or
close to it), use the Eyedropper tool and the Info palette to evaluate how
close they actually are to neutral.

As humans, we are accustomed to seeing human skin tones all around us
every day. Therefore, we all notice it pretty quickly when a skin tone just
doesn’t look right. We notice problems especially quickly in photos of peo-
ple we know personally or see on a regular basis. Yet, from time to time, we
all see images of people who unintentionally look jaundiced, or seasick, or
like they’ve spent too much time in the sun. 
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If the bride wore a white dress, it should
look white (not ivory or some other pale
shade) in her photos. Photography by Tony
Zimcosky.

 



There are a few reasons for this. First, skin tones vary widely from person
to person and can change dramatically depending on the lighting, activity
level, exposure to sun, and even the person’s emotional state. Second, skin
tones are also finely detailed and feature hundreds of shades of color rather
than a few unified tones. Third, even subtle problems can be very obvious
to viewers. While you can get away with the grass being a little off-color, it’s
harder for viewers to overlook skin tones that miss the mark. 

Setting Your Goals. Now that you’ve examined your image carefully and
(hopefully) made a few notes on things you’d like to see changed, it’s time
to set your goals for the image. This might seem obvious—you want it to
look “right,” right? Determining what is “right,” however, requires you to
make an important decision: should the color match the subject or scene as
it was, or should the color be changed to enhance the scene or subject?

In some cases, this decision is made for you. If your image shows a prod-
uct where the color needs to be correctly reflected, any “enhancements”
won’t be appreciated. In most other cases, there will be some creative lee-
way—and often improvements will make the image much more desirable. 

Some of the choices you can make to enhance the color in your images
will produce subtle (but much appreciated) results. For example, most
women will appreciate the smoothing effect of making
their skin tones slightly lighter than they actually are,
especially when this helps to open up shadows and con-
ceal texture. (In fashion magazines, you’ll see the skin
tones are often extremely light for this reason.) The skin should not, how-
ever, look too pink. For portraits of children and babies, on the other hand,
people tend to prefer a look that is slightly lighter and more rosy than in a
grown-up portrait.

Make the Corrections. When it comes to making color and contrast correc-
tions, Photoshop offers a multitude of options. Teaching you how to use
each and every one of these would require an entire book—and countless
books have been written on the subject. Understanding how to use these
tools (such as the Levels, Curves, Selective Color, and Hue/Saturation com-
mands) is key to building a successful workflow. So, invest in a good book
or take a workshop, then spend some time using these tools on your own
images. Train your mind and your eye to identify problems and devise the
most efficient solutions.

Make Additional Enhancements. Once you’ve gotten the color and
contrast in the image the way you want it, you can consider adding addition-
al enhancements, such as retouching, artistic filter effects, and more. 

Retouching. Virtually all images of people will need at least some degree
of retouching. Digital portraits are often so sharp that they actually show too
much detail—things like pores, very fine lines, and tiny discolorations that
people definitely don’t want to see in their images. In Photoshop, the Clone
Stamp tool and Healing Brush can be used to conceal small problem areas.
The Gaussian Blur filter can also be lightly applied to add overall softness to
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the skin. For best results, apply this on a duplicate of the background layer,
then use the Eraser tool on the softened duplicate layer to reveal the sharp
data on the underlying image layer.

Artistic Filter Effects. In addition to those filters that come packaged with
Photoshop, literally thousands of third-party filters are available. These small
accessory programs can be installed on your computer to add new and excit-
ing effects. In our studio, we have absolutely fallen in love with Nik Soft-
ware’s easy-to-use plug-ins, and we utilize them often to create a number of
interesting effects in our images. 

Monday Morning from Nik Software’s Color Efex! line is a studio
favorite. This filter creates a soft and very moody rendition of the image and
allows you to fine-tune the results if necessary. The Pastel filter replicates the
traditional look of pastel artwork with amazing accuracy. The Sunshine filter
can add punch to a flat, low-contrast image. These are just a few of the many
filters that are included with each plug-in set. I am sure that each photogra-

pher will discover different ways to
use these plug-ins to enhance their 
photography.

Converting a Color Image to 
Black & White. Unlike film shooters,
digital photographers do not have to
decide whether an image should be
color or black & white at the time of
capture. The photographer can now
make these decisions after the shoot
with no discernable loss in the qual-
ity of the final photograph. This pro-
vides a tremendous advantage to
photographers in any field of inter-
est. Although some cameras have a
black & white setting, I would
strongly recommend not using that
setting and capturing the image in
color. This way, you have not limit-
ed the possible applications and
modifications of the image like you
would if the image were digitally
recorded in black & white.

One method for converting your
images to black & white is to use
Nik Software’s  B/W Conversion, a
versatile filter that creates a black &
white conversion by applying digital
versions of traditional photographic
filters used in black & white photog-
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Filters can be used to add artistic effects to
your images. Photograph courtesy of Lisa
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raphy. Adjustments are made to the image using three slider controls:
Brightness, Filter Strength, and Spectrum. As the name implies, the
Brightness slider allows the photographer to make small or large adjustments
to the brightness level of the converted black & white image. This adjust-
ment is necessary when the chosen filter darkens the image too much. The
Filter Strength slider defines the degree to which the filter will affect the final
black & white image. The Spectrum slider defines the color of the filter you
are using with the black & white conversion. As in conventional black &
white photography, using a color filter changes how objects in the scene
appear. The entire color spectrum is available with this filter, so you can cus-
tomize your results to achieve the very best image.

The following additional black & white conversion techniques are from
Traditional Photographic Effects with Adobe Photoshop by Michelle Perkins
[Amherst Media, 2002].

With any conversion to black & white, you’ll have the best results if the
image is good to begin with—accurately color balanced with good contrast
and detail in the highlights and shadows. You’ll be happiest when you select
photos to “transform” that have a strong design and don’t rely primarily on
color for their impact. Obviously, this is not always possible (you may have
a color photo that looks best in color but must be used in a black & white
newspaper). In this event, using the techniques described will be especially
important for creating the best-possible results. 

Once you have color corrected your image and have achieved a good
tonal range and contrast, you are ready to convert the image to black &
white. The simplest method is to change the color mode of the image to
Grayscale (Image>Mode>Grayscale). This method, however, will not usual-

106 MASTER GUIDE FOR PROFESSIONAL PHOTOGRAPHERS

With digital photography, you can shoot all
your images in color, then selectively con-
vert them to black & white after the shoot.
Photograph by Patrick Rice.

 



ly produce the best-possible results, but they
can often be acceptable—especially if you
tweak them by slightly bumping up the con-
trast and brightening the midtones.

Better results can be achieved using the Lab
color conversion method. Converting a color
image to black & white using this method pro-
duces a crisp image with very little grain and
deep blacks.

1. Open an RGB image. If there are any lay-
ers in the image, flatten them. 

2. Go to Image>Mode>Lab color.
3. In the Channels palette

(Window>Channels), click on the
Lightness channel to change your image
to black & white. 

4. Drag the “a” channel into the trash can at
the bottom of the palette (leaving this in
place isn’t a problem, but it will create an
unneeded alpha channel).

5. Go to Image>Mode>Grayscale, then
Image>Mode>RGB Color. (You cannot
convert directly to RGB Color from Lab
color.)

6. If you like, you can still review the histo-
gram in the Levels dialog box to ensure
the tones are represented in the best way.

Going to Image>Adjustments>Desaturate is a
quick way to convert a color image to black & white. However, it results in
slightly more grain than the Lab Color method and produces slightly flatter
results. It’s still a useful operation, since you can apply the change to a layer
(unlike with the Lab Color method). 

Digital Handcoloring. With traditional handcoloring, it was sometimes
difficult to accurately re-create the color that appeared in the original pho-
tograph. The areas of the photograph that could be changed were limited.
For instance, the dark-gray areas of a black & white image could not be col-
ored easily; the color would barely show through, if at all. With digital, how-
ever, the process of adding subtle or vibrant color to any area of a black &
white image has never been easier. Like most tasks, handcoloring in Photo-
shop can be accomplished in several ways. The following are two common
methods. Both are adapted from Traditional Photographic Effects with Adobe
Photoshop by Michelle Perkins [Amherst Media, 2002]. Please consult this
book for a more complete look at this topic.
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Subjects with graphic shapes are ideal can-
didates for presentation in black & white.
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Handcoloring your images can be done
quickly and easily in Photoshop. One
method for accomplishing this involves us-
ing layers, a method that allows you to pre-
cisely control the degree of color you add to
your image and the placement of that color.

1. Begin with an image in the RGB Color
mode (Image>Mode>RGB Color). If
you want to add handcolored effects to
the color image, proceed to step 2. For
the more traditional look of handcolor-
ing on a black & white image, go to
Image>Adjustments>Desaturate to cre-
ate a black & white image in the RGB
Color mode.

2. Create a new layer (Layer>New>Layer)
and set it to the Color mode using the
pull-down menu at the top of the
Layers palette.

3. Double click on the foreground color
swatch to activate the Color Picker.
Select the color you want and hit OK to
set it as the foreground color. This is
the color your painting tools will apply.
You may switch it as often as you like. 

4. With your color selected, return to the
new layer you created in your image.
Click on this layer in the Layers palette
to activate it, and make sure that it is set
to the Color mode.

5. Select the Brush tool and whatever
size/hardness brush you like, and begin
painting. Because you have set the layer mode to Color, the color you
apply with the brush will allow the detail of the underlying photo to
show through. 

6. If you’re a little sloppy, use the Eraser tool (set to 100 percent in the
Options menu) to remove the color from anywhere you didn’t mean to
put it. Using the Zoom tool to magnify these areas will help you work
as precisely as possible.

7. If you want to add more than one color, you may wish to use more
than one layer, all set to the Color mode.

8. When you’ve completed your “handcoloring,” the image may be either
completely or partially colored. With everything done, you can flatten
the image and save it as you like. 

108 MASTER GUIDE FOR PROFESSIONAL PHOTOGRAPHERS

Digital handcoloring can add an elegant
touch to a black & white image. Photograph
by Rob Ledwedge.

 



Image desaturation can also be combined with layers to produce a hand-
colored look in seconds—or, with a little refinement, to avoid having to
select colors to handcolor with. This technique works only if you are start-
ing with a color image.

1. Begin with a color image in the RGB Color or CMYK Color mode.
2. Duplicate the background layer by dragging it onto the duplication icon

at the bottom of the Layers palette. 
3. Desaturate the background copy by going to Image>Adjustments>

Desaturate. The image will turn black & white, but by reducing the
opacity of the desaturated layer you can allow the colors from the
underlying photo to show through as much or as little as you like.
Allowing a bit of color to show through creates a very nice look.

4. To add a few extra pops of color to the image, use the Eraser tool to
reveal the underlying color photo. Adjust the opacity of the Eraser to
allow as much color to show through as you like. 

Toning Photographs. Sepia toning by traditional means produced beautiful
images, but the process was anything but pleasant. I don’t think I’ll ever be
able to erase the memory of the rotten-egg smell of the chemicals. This
alone would prevent me from doing any traditional sepia toning or offering
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Digital sepia toning produces a classic look
that is much simpler to create than when
using traditional methods and materials.
Photograph by Dennis Orchard.

 



it to my clients. In fact, I experi-
mented with other ways of achieving
a brown tone in a black & white
print. Most consumers can’t tell the
difference between a true sepia-tone
print and any other print with a
brown cast to it, so I typically made
a pot of black coffee and filled a
print tray with it. I then dropped my
black & white images into the liquid
and stained the entire print brown.
Although I got away with “cheat-
ing,” I knew that the images never
looked like real sepia prints. The
digital darkroom has changed this. 

Photoshop allows you to use a
sepia action, which is accessed via
the actions palette, the Hue/Satura-
tion feature, or a Photo Filter Ad-
justment Layer. With any of these
techniques, sepia toning is both fast
and efficient, and I believe the artis-
tic digital black & white printmaker
has even more creative control than
he ever had in the past. 

We have begun creating color-
toned images for many of our por-
trait clients. In many of today’s fash-
ion magazines, you will see images
that are monotone with a single
“extreme” color. These striking and
unusual photographs immediately
grab your attention. I create this
look by using my digital darkroom, Photoshop. 

To begin, I open my black & white image in Photoshop, then go to
Image>Adjustments>Curves. The default Channel setting is RGB. By click-
ing on the arrow to the right of the Channels field, you can access each of
the three channels separately. By selecting the Red channel, for example, you
can make adjustments to that individual channel. With the Red channel
selected, you will achieve a red-toned image by pulling up on the curve;
when the curve is bent downward, a cyan hue will be achieved. The degree
of the toning is controlled by the amount that the curve is altered. 

The following is another technique for making this conversion. It is
excerpted from Traditional Photographic Effects with Adobe Photoshop by
Michelle Perkins [Amherst Media, 2002].
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Toning is combined with vignetting (darken-
ing at the edges of the image) in this
charming portrait. Photograph by Drew
Smith.



1. Begin with a digital image in the RGB Color mode.
2. Open the Hue/Saturation dialog box

(Image>Adjustments>Hue/Saturation). Click on the Colorize box and
be sure to activate the Preview box as well.

3. Adjust the sliders to create whatever color (hue) and intensity of color
(saturation) you like. Adjusting the lightness slider will adjust the overall
lightness of the image, which you can also do as you see fit. 

4. When you get the look you want, hit OK to apply the effect. 

Toned images are popular with today’s clients; they like the look, want to
make a statement with their pictures, and want their photos to be unique.
This toning technique allows us to give these clients an unusual product
without having to shoot any differently—it’s all done post-capture.

Photoshop Actions. Using actions is one of the easiest and most powerful
ways to make your workflow more efficient. In the following section by pho-
tographer Michael Bell, we get a look at the basics.

Actions are a powerful tool in Photoshop, allowing you to “script” a series
of changes to an image and replay these changes on any image at the touch
of a button. This works well for tasks where you need to do the same thing
to many images. In the example that follows, you’ll see how I create and use
an action to make a basic image adjustment, convert my JPEG-format cap-
tures to TIFF files, and save these files in a new folder. Why should you con-
vert to the TIFF format? Resaving images as JPEGs means that you will be
losing additional data due to compression each time you save. Remember,
JPEG is a “lossy” compression scheme, meaning that to save as a JPEG, the
computer compares the data in the file and determines what data can be
“thrown away” to reduce the file size. Then, the computer will “make up”

the missing data when the file is opened. Doing so once,
you lose data. Doing so again means you lose more of
the data the computer has already determined to be
good data, when it “throws away” more data to com-

press the file. Therefore, once I open a JPEG, I do not resave the file as a
JPEG unless I really have to. I do, of course, retain the original JPEG files
in a separate folder so that I can always come back to them if I should need
the original file again.

Before creating this action, I go to Window>File Browser and rotate my
images as needed. To do this yourself, select the thumbnail view for the
desired image in the File Browser (if more than one needs to be rotated, just
press the Shift key and click on as many files as you want). Then, hit Control
+ [ to rotate the images to the left (counterclockwise) or Control + ] to
rotate the images to the right (clockwise). Photoshop only rotates the
thumbnails until you open the files, then it opens and rotates the files. With
this step complete, I close the File Browser.

The next step is to record the action. I go to the actions palette and select
New Action from the pull-down menu at the top right of the palette. I name

AFTER THE SHOOT 111

Actions are a powerful tool, allowing you to

“script” a series of changes to an image.

 



the action and hit the record button (the round button) at the bottom of
the palette. From this point on, any change I make will be recorded.

I prefer to record an action to do more than one thing. For example, I
open one image, change the image size and resolution, and sometimes test
the Auto Color or the Auto Levels (they don’t always work, but in some
cases they are close). Then I go to File>Save As and select the TIFF file for-
mat, and save the image into a new folder, not back into the JPEG folder. 

Having completed these steps, I close the image and then press the square
button at the bottom of the actions palette to stop recording.

To play the action, I open another JPEG file, select the newly created
action from the actions palette, and hit play (the triangular button).
Photoshop will rotate the file as specified in the File Browser, and the action
will adjust the file, save it as a TIFF, then close it.

Once the action is working, I go to File>Automate>Batch. With the fol-
lowing settings in place, this will cause Photoshop to open each of the
images and apply the newly created action. At the top of the dialog box, I
select my new action. Then I go to Source Folder, click on Choose, and
point the way to the folder containing the JPEGs. For the Destination
Folder, I click on Choose and point the way to the new folder where I want
to store the resulting TIFF files. For file naming, I select Document Name
+ Extension and make sure Stop for Errors is selected. That’s it—I just click
OK, and I’m finished. 

When you’ve completed the above steps on your own images, you can go
out for a Coke. If the JPEG folder has fifty images, Photoshop will run all
of them and then stop. There is nothing to limit you as to how many files
you can open, unless you run out of RAM. Photoshop should still try to
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By creating an action to apply the sepia-
tone effect you like, you can ensure quick
results that will always match from image to
image. Photograph courtesy of Visualiza-
tions Photography.

 



open the files, even in this event, but
it will be slow.

To make Photoshop run better,
go to Edit>Preferences>Memory &
Image Cache and set the Cache Lev-
els to 4, unclick Use Cache for
Histograms (this means that Photo-
shop will create histograms only
when it needs them, not every time
you open a file and use RAM). I set
the percentage of RAM for Photo-
shop at 85 percent. If you do a lot of
multitasking (with many programs
open at once), then 85 percent is
good; if you only run Photoshop
and nothing else at the same time,
you can set this up to 95 percent and
speed up Photoshop. 

You also should be logged on to
Windows XP or Windows 2000
Professional as a Power User, not as
the Administrator. When you are
logged on as the Administrator,
Windows loads a lot of behind-the-
scenes programs the administrator
usually needs, but those programs
hog RAM and slow down both
Windows and Photoshop.

Digital Workflow
Digital workflow includes all of the steps required in the photographic
process—from capture, to enhancement, to output. Because most digital
shooters handle the image storage, some digital retouching or color correc-
tion, and sometimes even output, workflow can seem a daunting task for
beginners and pros alike. The following are some guidelines for implement-
ing an efficient and effective digital workflow strategy that will allow you to
free up some of your time for your first love, creating images.

Image Storage. Our studio employs very simple digital workflow proce-
dures. Our images are written onto CF cards as they are captured. After the
session, the uncorrected files are written to a CD or DVD (the files are
stored exactly as they were captured in the camera). The CD or DVD is
labeled with the subject’s/client’s name, the date, and the photographer’s
name. (We use a special marking pen designed specifically for writing on
CDs that eliminates the possibility of the ink bleeding into the data and cor-
rupting the files.) 
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room! Photograph by James Williams.
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In addition, we back up all of our
image files by copying them to a re-
movable hard drive. Using a removable
drive is important because it can be
moved from computer to computer.
Many photographers I know even take
their removable hard drive home at the end of the day; this way, if the files
at the studio are lost due to theft, fire, or flooding, there is a safety net.

Proofing. Slideshows. To show our clients their images immediately after
the session, we load the CF card into our card reader and open the images
using Fuji StudioMaster Pro. This software allows us to quickly rotate every
image, then show the client a slideshow of their entire session. We can even
use this versatile software to compare images on the screen and help them
choose the best shots. Their orders can be placed right on the spot. This
saves us considerable time and money and helps to expedite the ordering
process. 

Paper Proofs. We only create paper proofs if the client is willing to pay a
$250 deposit to take the photos out of the studio. To produce paper proofs,
we open the unretouched images CD or DVD, make changes and correc-
tions to the image files, and save them to a second disc. The original CD or
DVD is never altered and never leaves the studio. The disc of retouched
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and/or corrected files is sent to the color lab, and the paper proofs are print-
ed. When the proofs are delivered to the studio, the proofing CD or DVD
is placed in the client file along with the unretouched image CD or DVD as
a backup. 

When orders are placed from the images, another CD or DVD is written
with the changes and corrections made to the images. This third CD or
DVD is sent to the lab and the necessary enlargements are printed. Once
returned, this CD or DVD is also placed with the client file. We now have a
permanent history of each image presented to the client. 

At our studio, the computers used to work on the clients’ image files are
not hooked up to the Internet. This way, we never have to worry that a com-
puter virus will damage or destroy irreplaceable client image files. Too many
times photographers have found their images impacted by a computer virus
or worm.

Retouching and Color Management. One of the biggest challenges
digital photographers face is producing images that will reliably print cor-
rectly (in terms of their color and contrast) and feature a consistent look in
terms of retouching. 

Too often, photographers spend so much time in front of the computer
(instead of behind the camera) that they essentially eat up all of their prof-

its. Instead, consider delegating some image-editing
tasks to a qualified member of your staff. 

You should also strive to create a consistent, stan-
dardized method of post-processing so that the results

achieved will be identical, regardless of who in your studio makes the adjust-
ments. For instance, instead of allowing each image retoucher to apply a
sepia effect in their own way, set up an action that all retouchers will use on
all images to be presented in sepia. Not only will this provide consistent
results, it will also expedite the retouching process.

Lab or In-House Printing? Digital output is probably the biggest area
of concern for today’s buyers of photography. As digital imaging evolved,
two unique problems occurred with regard to digital output. First, many
early digital cameras had too small a file size to make adequate quality
enlargements. Both consumers and photographers were trying to enlarge
digital images beyond the point of acceptability, resulting in pixelation. The
second early problem with digital output was the quality of the printers that
were available to both professionals and consumers. The inks on early inkjet
printers were not true to the color in the scene, and the papers that the prints
were created on did not last. In other words, the images might fade or shift
colors over time. Digital output turned many people off to digital imaging.

Today, this is all changed. First of all, it is not necessary for the profession-
al photographer to print any of his  own digital images. Just about every pro-
fessional color lab now accepts digital files and makes prints on Kodak or Fuji
photographic paper. Moreover, these labs use the same machines, in many
cases, to print either film or digital files. This is a very important selling point
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when we discuss digital imaging with our clients. Some clients have the mis-
understanding that their digital prints will not last. This is due in part to
experiences with early inkjet prints and in part to misinformation from pub-
lications and photographers. Once our clients know that, whether their
images are captured on film or digitally, the same Fuji Frontier Printer will
generate their photographs and print them on the same Fuji Crystal Archive
paper, they are much more comfortable with the fact that we are a digital
studio.

Printing it Yourself. Many studios, including ours, use in-house printers
for specific applications. When you calculate the cost of ink cartridges, paper,
waste, and time, however, the prints that we make in-house cost more than
sending the files to the lab for prints. In addition, professional color labs are
more consistent in color and density than most photographers will be in-
house. I have known several photographers who have attempted to print
some of a bride and groom’s 8x10-inch prints themselves on their inkjet
printer, only to have the couple reject the images for lack of quality when
compared to a lab print. As with any photographic print, the real test is when
they are compared to another print from the same event that was printed on
a different machine or paper.
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Watch other photographers’ work and look
for ideas that will help you create more sal-
able images for your clients. Photographs
courtesy of Visualizations Photography (top
left), Robert Williams (above), and Bob
Kunesh. 

 



There are a variety of printers available at a variety of price points. A few
of these options are outlined below.

Inkjet Printers. New-generation inkjet printers are capable of making
high-quality prints. Although I have met photographers who print their own
4x5-inch or 4x6-inch proofs on these printers, this is not a cost-effective
option. Many of the larger discount and department stores can produce
proofs from a Fuji Frontier Printer on Fuji Crystal Archive paper at a cost of
about $.20 each with turnaround times from one hour to next day.
Professional color labs have also become more competitively priced in the
area of digital proofing. As a result, your color lab can produce your proofs
for far less money than you can yourself.

In our studio, we have used the Epson line of printers for many years. The
reproduction quality of their printers is very impressive, and the printers
themselves just keep getting better. Sometimes a client needs an image
“right now,” and these printers are perfect in that application. Also, if we

miss an image from an order, we can print the
photograph ourselves rather than send the file
back to the lab for an enlargement and hold up
the production process. Every studio should
have one of these inexpensive printers to help
them out in similar situations.

Dye-Sublimation Printers. Dye-sublimation
(dye-sub) printers heat dry colorants to a gas
state then transfer them to a paper where they
solidify. The inks are topped with a coating that
makes these images more archival than inkjet
prints (of course, the improved appearance and
durability of the prints come at a cost: both the
printers and the inks they require cost more than
an inkjet printer). 

We use a small dye-sub printer to produce
quick digital prints at wedding receptions. We
select one digital image from the wedding day
and print three copies of it, then place each print
inside a folder with our studio logo imprinted on
it. We then present these portrait miniatures to
the bride and groom and each set of parents dur-
ing the dinner. Their reaction is always one of
amazement and appreciation. The images are
passed around the room from guest to guest,
which certainly helps us to secure future clients.
Our cost is about $1 per print and $.50 per
image—and the positive public relations value is
certainly well worth the modest investment!
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You’ve read through all of the chapters of this book
and now have a solid understanding of the basics of

photography—from cameras and lenses, to composition,
to lighting, exposure, and metering, to digital post-pro-
duction and output. How can you take the next step in
becoming a professional photographer?

There are literally hundreds of thousands, maybe even
millions, of individuals who profess to be “professional”
photographers. Completing the Professional Photog-
raphers of America’s Certified Professional Photog-
rapher program helps you to stand out from your peers.
PPA certification is the only nationally recognized cre-
dential for professional photographers. With recent
changes to the program, PPA has set objective standards
for job knowledge and performance that will enhance
the program in both the eyes of consumers and of imag-
ing professionals. Professional credentials are one of the
few ways that the public can differentiate between pho-
tographers. Let’s face it, photography is an unregulated
industry. Anyone with a camera can claim to be a profes-
sional photographer. Buy a camera, get some business
cards printed, maybe create a simple website—now
you’re a professional photographer. Certification helps
to separate you from the masses.

Photographers benefit from the PPA Certification
program both as a gauge of their professional compe-
tence and as a tool for marketing their services. Once
you become PPA Certified, you’ll receive promotional
materials, as well as PPA Certified listings in both PPA’s
member directory and their “Find a Photographer”
search engine.

The following text, available on the website http://
certifiedphotographer.com at the time of this writing,

describes the many benefits, in PPA’s words, of earning
your certification. 

Certification is the most common, well-known, and
respected professional credential. Clients seek out
credentialed professionals, and people recognize
certification as a sign that you are an authority in
your field. So it makes sense for you to be a
Certified Professional Photographer to better mar-
ket yourself to your clientele. Here are some specific
ways certification can help you in your business.

Get Folks in the Door. Before you can show a con-
sumer your portfolio or sell them on your services,
you have to get them into your studio. With hun-
dreds, sometimes thousands, of photographers
advertising in a market, this is not always an easy
task. Advertising as a Certified Professional
Photographer is one way to distinguish yourself
from the masses. Certification gives clients a con-
crete business reason to put you on their short list.
It’s a third-party validation of your expertise, and
that speaks volumes to clients about your skill.

Justify Your Prices. The digital era has made it
much easier for inexperienced part-time and fly-by-
night photographers to throw their hat into the
ring, undercutting professionals with rock-bottom
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sonal protection for photographers everwhere. For more informa-
tion, visit www.ppa.com.

 



prices. Certification is an easy way to help con-
sumers understand and appreciate your level of
experience and talent.

Don’t be afraid to explain to consumers how dif-
ficult it is to get this credential. You had to pass a
very difficult written examination, and a scrutinizing
panel evaluated your work. Additionally, let them
know you have to recertify every five years. This
ensures that Certified Professional Photographers
are keeping their quality, skills, and knowledge up-
to-date. Ask potential clients how much they really
know about your competitor’s work. If he turns out
to be a bad photographer, a lot of time and money
will have been wasted. In the long run, it’s often
cheaper to choose someone they know is qualified.

It’s a Great Tiebreaker. It would be nice if every
customer who looked at your work was immediately
convinced to hire you, but that’s not realistic.
Consumers can be indecisive when all the photogra-
phers they’ve interviewed take beautiful shots, have
similar prices, and seem like nice people. In many
instances, certification can be a deal clincher. Most
consumers aren’t experts on photography, and they
don’t know how to select the most qualified pho-
tographer. So stack the deck in your favor by pro-
viding them with an expert opinion on your knowl-
edge and skills. As a Certified Professional Photog-
rapher, you have passed a written photography exam
and a panel of experts have reviewed your images
and judged you qualified. Can your competition say
that?

This site provides a wealth of information, including the
certification application, exam dates and test specifica-
tions, image review guidelines, and more. You can learn
more about membership in the Professional Photog-
raphers of America and read more about other topics of
interest to photographers by visiting the association’s
website at www.ppa.com.

What’s Involved?
There are three important steps you must take to
become a PPA Certified Professional Photographer. 

Application. First, you must fill out an application.
Within three years of the date your application is filed,

you must take the written exam and submit your images
for review by a panel of judges. (At the time of this writ-
ing, there was a $100 fee required when filing the appli-
cation for certification.)

Image Submission. Image reviews are held four
times per year. The photographer must present twenty
images for review by the certification panel. These twen-
ty photographs must be compiled from twenty real 
job assignments, created within twenty four month’s of 
the date of the image submission. No two assignments
entered for image review may contain the same subject.
Images must be submitted as prints or on DVD and
should reflect in proportion the kind of work that is typ-
ically provided to clients. For more information on the
specifics of presenting the images and other pertinent
image review guidelines, go to http://certifiedphotog
rapher.com.

The Written Exam. PPA’s written exam currently
tests photographers’ knowledge in six areas. Listed
below are the fields of knowledge and the percentage of
the test that is comprised of questions from that area of
expertise. (Test Information Disclaimer: The information
in this text is current as of the time of this writing.
Changes with the PPA Certification exam and/or the
exam process can happen at any meeting of the PPA
Certification Committee.)

• camera, lenses, and attachments (15 percent)
• composition and design (17 percent)
• digital post-production (13 percent)
• exposure and meters (20 percent)
• film, digital capture, and output (15 percent)
• lighting (20 percent)

All PPA Certification written exams are now created
specifically for the candidate. As a member of the PPA,
you choose your photographic specialties to reflect the
type of photography you perform. Your exam is pre-
pared in advance, is preprinted with your name on the
exam packet and answer sheet, and is sent to the proctor
to be properly administered. Only PPA Certification
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staff, committee members, and state liaisons can proctor
the PPA Certification written exam. 

The PPA follows a very strict guideline for the distri-
bution and handling of the PPA Certification written
exams. This exam packet is sent sealed from the PPA,
and the seal is not broken until the candidate begins the
exam in the presence of the proctor. No scrap paper is
provided, so the candidate can write on the exam book-
let itself. The answer sheet is scannable; therefore, the
bubbles on the answer sheet must be completely filled in
using a number 2 pencil. There is also an exam survey
for the candidate to complete for feedback to the Certi-
fication Committee. At the completion of the exam, the
candidate should place the exam booklet, answer sheet,
and the survey back into the envelope. The proctor
should then place the packet seal sticker on the envelope
in the presence of the candidate.

The proctor must fill out a Certification Examination
Report Form, which lists how many exams were sent,
how many exams were returned, the date, the proctor’s
name and address, the number of examinees, the length
of time the examinees needed to complete the exam, any
additional comments, and the proctor’s signature. The
proctor should return all materials to the PPA in the
enclosed Federal Express packaging.

Preparation
While some photographers have gone into the certifica-
tion exam “cold turkey” and passed, I strongly advise
against this approach. Even a little preparation will go a
long way in helping you be successful. I passed the PPA
Certification exam in 1988. Without formal training in
photography and having been out of college for eight
years, my approach was to read everything I could that I
thought might be relevant to the exam. The test was a
lot different (and more difficult) back then. There were
several questions on the history of photography, view
camera techniques, and both black & white and color
processing. I remember purchasing a Calumet Combo
view camera and learning how to use it just so I could
complete the questions related to view cameras on the

test. All of this has changed. Although the test is not
perfect, the PPA Certification Committee has worked
diligently to make the test more relevant for today’s
working professional photographer. In fact, I was serv-
ing on this committee the year we removed the history
questions from the exam.

How to Approach a Multiple-Choice Test
Many individuals who take multiple-choice tests score
lower than they should because they spend too much
time on questions they find difficult, leaving insufficient
time to complete the exam. Remember, you only have
two hours to complete the test.

Don’t be overwhelmed by questions that you can’t
answer. One trick is to follow this testing procedure.

1. Answer any easy questions immediately.
2. On your exam booklet, write a “+” sign next to

any question that you think you can solve but will
need to spend some time on.

3. On your exam booklet, write a “–” sign next to
any question you do not feel you can answer.

After you have answered all of the questions you found
easy, go back to those questions you designated with a
“+”  and begin working on them. If you finish all of
them, attempt to answer the questions that you desig-
nated with a “–” sign. Sometimes these questions may
seem impossible at first, but you may gain confidence in
your answer later on.

Also, when you first read through the questions, cross
out the answers that you are certain are not correct for
those items you marked with a “+” or “–”. This is com-
monly referred to as the elimination method of taking an
exam. Even if you do not answer the question on the
first read through, the elimination method will save you
time when you come back to the question later on.

An instructor will frequently take a line from the cur-
riculum textbook and change or add a word to com-
pletely change the meaning of a question. Often, for
instance, the synonym of a familiar term may be used,
and failing to understand the less-common term could
result in confusion and incorrect answers. The main rea-
son these questions are included is to catch the person
who is merely memorizing information from a textbook.

120 MASTER GUIDE FOR PROFESSIONAL PHOTOGRAPHERS

The PPA follows strict guidelines for the 

distribution and handling of written exams.

 



Also, persons who have taken the test several times may
glance at a question, not realizing it appears subtly dif-
ferent from previous tests, and may therefore incorrect-
ly answer the question.

Errors of this kind are referred to as misreads. To
avoid misreads, circle what it is that you must answer in
a question. By looking at what was circled, you will be
able to quickly understand the heart of the question and
eliminate obviously incorrect answers.

I want to share just a couple of closing thoughts
regarding taking multiple-choice tests to help you with
the experience. Don’t get stuck on one problem. Some
examinees waste far too much time racking their brain
on a particular question and then feel rushed to get
through the rest of the exam. Know when to skip a ques-
tion, and use the coding system described above to mark
questions that will require more time. Being in a hurry
will usually result in careless mistakes. When taking tests
that have a test booklet and separate answer sheet, be
certain you are filling in the bubble that corresponds
with the question you are answering. 

Once you have completed the exam, be sure that you
have filled in a bubble for each question. If you are
forced to guess, you have a 25 percent chance of getting
the answer right. If you don’t answer at all, you can be
100 percent certain to get that question wrong. Make
sure that you did not mark two answers for any single
question. If you erased an answer and changed your
mind, be sure that you completely erase the unwanted
answer. The computer that scans your answer sheet
could read a partially filled-in bubble as an answer and
will signify an incorrect response if more than one
answer is detected.

Promoting Your Certification Credentials
Once you have met all of the requirements to receive
your accreditation as a Certified Professional Photog-
rapher you will be sent an achievement certificate that is
suitable for framing. You can purchase one of several
frame options for your certificate directly from PPA
(www.ppa.com/files/public/cert-frames.pdf) or can
purchase a frame on your own. Either way, you need to
make sure that this certificate is prominently displayed in
your studio where your clients will see it. The personal
satisfaction of achieving PPA Certification is certainly

important, but you should promote this accomplish-
ment to all clients. 

You will also receive some 1-inch PPA Certification
stickers, a window decal, and some PPA Certification
brochures that you can provide to prospective clients.
We apply the stickers to the corner of the letters we send
to prospective clients and include the certification
brochure in each mailing. The window decal is promi-
nently displayed on our studio’s door. 

There are other ways that you can let your customers
know that you’re certified. You can purchase a PPA
Certification lapel pin from the association for a small fee
(currently $15.00; we wear these pins on our tuxedo
jackets when we photograph weddings) and can also
sport a logo on your attire. PPA once offered polo shirts
with the PPA Certification logo on them. As of this writ-
ing, they are no longer doing that, but that may change
in the future. I have several of these polos and wear one
to the studio when I go in to work. Even if these shirts
are not available through the PPA, you can bring the
logo to any custom embroidery shop so that it can be
scanned and stitched onto a shirt or other item of your
choosing.
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Contributors
Penney Adams—Penney graduated with honors from the

Dawson Institute of Photography in Montreal, Canada, and
has photographed families, weddings, and other events
throughout the United States, Canada, and Italy. In addition
to being the owner and operator of Adler House
Photography, she has been honored to serve on the Board of
Directors for PPO and the Professional Photographers of
Central Ohio. As a member of PPO, Penney was honored to
receive the Ohio Fuji Masterpiece Award twice.

Michael Ayers—The recipient of two Master of
Photography degrees and the United Nations Leadership
Award, Michael has made a career of giving back to the pho-
tographic industry. He has invented album designs and 
construction concepts, authored countless articles and books,
and has lectured to more than 40,000 photographers world-
wide. To view samples of his work, visit his website at
www.TheAyers.com.

Michael Bell—Michael Bell received his Master of
Photography and Photographic Craftsman degrees in 1998,
and was the first photographer to receive both degrees simul-
taneously. He received his Certified Professional Photog-
rapher status from PPA. Mike has also achieved great success

in print competition, with two of his prints having been
accepted into PPA’s Loan Collection. His work has been fea-
tured in Rangefinder and Storytellers.

Mark Bohland—Mark is a professional photographer
from Mansfield, Ohio. He has earned his Certified Pro-
fessional Photographer and Photographic Craftsman degrees
from PPA and is only a couple of merits from receiving his
Master of Photography degree from PPA. His award-winning
images have been included in the PPA Loan Collection. 

Lisa Farnholz—Lisa is a PPA Master Photographer and
Certified Professional Photographer who specializes in chil-
dren’s photography. Her images have won numerous awards
in PPA competitions and inclusion in the PPA Loan
Collection.

Rick Ferro—Rick holds a Master of Photography and
Photographic Craftsman degree from PPA and is one of the
nation’s leading wedding photographers. In 1993, Walt
Disney World approached him to create a wedding photogra-
phy department. Rick became senior wedding photogra-
pher—and Disney World became the world’s most sought-
after wedding destination. Rick went on to serve as a photog-
rapher for ABC’s Weddings of a Lifetime and for weddings on
Live with Regis & Kathy Lee. He is the author of Wedding
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Photography: Creative Techniques for Lighting, Posing, and
Marketing (3rd ed., 2005) and coauthor of Wedding Pho-
tography with Adobe® Photoshop® (2003), both from Amherst
Media.  

Richard Frumkin—Richard’s professional photographic
career began while he was in college. He was a staff photog-
rapher at the University of Cincinnati where he worked on the
school newspaper and magazines. At the university, his study
of photography helped him to secure assignments as a photo-
journalist with the Cincinnati Enquirer. Rick worked for sev-
eral leading wedding photography studios before joining Rice
Photography. Rick has won several awards for his images.

Bernard Gratz—Bernard owns Portraits by Bernard in
Dover, Ohio. A professional photographer for over thirty
years, he holds the Photographic Craftsman degree from PPA
and has served as a councillor to that association. Bernard is a
past president of the Akron Society of Professional Photog-
raphers, has served on PPO’s board of trustees for more than
twenty years, and is a past chairman of PPO.

Leonard Hill, Jr., PPA Cert., CPP—Leonard is an
award-winning photographer from Zanesville, Ohio. He is
actively involved in both the PPO and the Professional
Photographers of Central Ohio. In addition to his photo-
graphic artistry, Leonard is an expert at website design; he
designed the website for PPO as well as numerous sites for
other professional phtographers.

Travis Hill—Travis holds PPA’s Master of Photography
and Photographic Craftsman degrees and was one of the asso-
ciation’s youngest recipients of these honors. He also holds
the Accolade of Lifetime Photographic Achievement from
WPPI. He has earned the degree of Certified Professional
Photographer from both PPA and PPO. He was a speaker at
the PPA Annual Convention in 1999 and WPPI in 2003 and
has lectured to audiences both large and small across the
country. His images have been selected for inclusion in the
PPA Loan book, PPA Gallery book, and the WPPI Annual
editions. Travis is coauthor of Infrared Wedding Photography
(2000), by Amherst Media.

Ken Holida—Ken is a professional portrait and wedding
photographer from Willard, Ohio. He holds the designation
of Certified Professional Photographer from both the PPO
and PPA. He also holds the Master of Photography degree
from PPA. Ken is very active in professional associations; he
serves as a PPA Council Delegate from Ohio and is a Past
President of PPO.

Jacob Jakuszeit—Jacob has been in love with photogra-
phy for many years. This passion for imaging led him to Rice
Photography, where he has worked as a wedding photogra-
pher for the past five years. Having photographed his first
wedding solo at age sixteen, Jacob’s images have earned him

awards in many photographic competitions. His grasp of dig-
ital imaging and photojournalistic style make him a great
image-maker.

Jesse Josleyn, Master Photographer, CR., M.E.I.,
C.P.P., A.S.P.—Jesse and his wife Patty own and operate a
small studio in northwestern Indiana. They specialize in sen-
ior class photography, portraits, fine art prints, digital com-
posites, and print restorations. To view samples of their work,
you can visit their studio at JosleynPhotography.com.

Bob Knuff—Bob is a professional photographer with over
forty years’ experience in the industry. He holds the Master of
Photography, Photographic Craftsman, and Certified Pro-
fessional Photographer degrees from PPA. He has served on
the board of trustees of PPO and has earned their Certified
Professional Photographer degree. He has also served as pres-
ident of the Triangle Professional Photographers Association.

Robert Kunesh—Robert is a retired graphic arts teacher
(1961–1991) who began his professional photography career
in 1967 as founder of Bob Kunesh Photography and later as
cofounder of Studio K Photography in 1986. Now retired
from the studio, he continues to work as a consultant, speak-
er, and freelance photographer. In his forty years as a profes-
sional photographer, he has earned the degrees of Master
Photographer, Craftsman, and Master of Electronic Imaging.
He has also achieved many awards, such as PPA’s Photog-
rapher of the Year Award for 2004 and 2005. He has received
the prestigious Kodak Gallery and Fuji Masterpiece Awards.
His images have appeared in over twenty books and more
than a dozen magazines. 

Rob Ledwedge—Rob is a professional photographer and
studio owner from Ohio whose work spans many genres. He
makes his living photographing weddings, graduations, and
other family milestones, but also enjoys architectural and fine-
art photography. In 2004, his work was honored in a gallery
exhibition at Tiffin University.

Chris Nelson—Chris is a professional photographer and
studio owner who has shot everything from advertising, to
weddings, to glamour. He holds a BA from the University of
Wisconsin and has earned Accolades of Photographic Mastery
and Outstanding Photographic Achievement from WPPI. His
glamour images have earned merits from WPPI and PPA.  

Dennis Orchard—Dennis is an award-winning photog-
rapher from Great Britain. He has been a speaker and an
award winner at WPPI conventions and print competitions.
He is a member of the British Guild of Portrait and Wedding
Photographers.

Michelle Perkins—Michelle is a writer and digital photo
retoucher specializing in wedding, portrait, and architectural
imaging. She has written for PC Photo and is a regular contrib-
utor to Rangefinder. She is the author of Beginner’s Guide to
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Adobe® Photoshop® (3rd ed., 2006), Color Correction and
Enhancement with Adobe® Photoshop® (2004), and Professional
Portrait Lighting: Techniques and Images from Master
Photographers (2006), all available from Amherst Media.

Barbara Rice—Barbara received her formal photographic
education from the Rhode Island School of Photography and
has gone on to earn numerous professional degrees, including
PPA’s Master of Photography and Photographic Craftsman
degrees. She holds the Accolade of Lifetime Photographic
Excellence and Honorary Accolade of Lifetime Photographic
Excellence Degrees from WPPI. Her creative wedding albums
have received the Fuji Masterpiece Award, and one was
accepted into the PPA Loan Collection. Barbara is a coauthor
of Infrared Wedding Photography (2000) by Amherst Media.

Charlene Rule—Charlene started her photography busi-
ness at the age of eighteen by shooting her first wedding.
Since then she has done almost every type of photography,
from food, to commercial, to school, to fine art. She is a
member of the Michiana Professional Photographers,
Propfessional Photographers of Indiana, and vice president of
the Photographer’s Guild of Goshen. She has won eight Silver
Star Awards, the William Lattimer Award, two Court of Gold
Awards, and Third Place People’s Choice, all since 2004.

Drew Smith—Drew is an award-winning professional
photographer with over twenty years experience. He holds
the designation of Certified Professional Photographer from
the Professional Photographers of Ohio and his images have
received numerous merits in PPA photographic competitions.

Lisa Smith—Lisa is an award-winning photographer and
studio owner from San Diego, California. She is a member of
the Digital Art Guild, San Diego; the La Jolla Art Association;
PPA; and WPPI; and her photographs have appeared in
numerous photography publications. For more information,
visit her at her website at www.LisaSmithStudios.com.

Visualizations Photography, Inc.—In May of 1999, a
dream became reality for Aaron and Joanna Patterson when
they opened Visualizations Photography. The main focus of
the business was portrait photography, and the studio placed
an emphasis on capturing the expressions and moments that
would be cherished for a lifetime. Since 2002, the couple has
added Kent State University graduates Amanda Flavelle,
Ashley Trainer, and Ryan Smas to their staff. Together, these
five photographers have made Visualizations one of the
largest all-digital portrait studios in  Ohio. All of the studio’s
photographers are certified through the state of Ohio and are
constantly challenging themselves with national and regional
print competitions. 

Edward Vullo—Edward Vullo’s career in wedding pho-
tography began when he was stationed in Germany with the
U.S. Air Force and members of his group asked him to pho-

tograph their wedding. Photography continued to be a hobby
until he was encouraged by an established wedding photogra-
pher to start charging a fee for his developing abilities.
Eventually, he took a chance and pursued wedding photogra-
phy full time. He took on associates and was soon booking
over 100 weddings a year. Today, Edward owns Foremost
Photography, in Parma, Ohio. 

James Williams—James is a professional photographer
from Champion, Ohio, with over twenty years’ experience.
He has earned the designation of Certified Professional Pho-
tographer from both PPA and PPO. In addition, James is the
recipient of the Accolade of Photographic Mastery degree
from WPPI. He is active in several photographic associations
and has served as president of SONOPP.

Robert Williams—Robert runs Robert Williams Photog-
raphy in Tallmadge, Ohio. His portrait and wedding images
have won several awards in local, state, and national competi-
tions. He holds a Master of Photography degree from PPA.
He has also earned the Certified Professional Photographer
degree and Advanced Award Medallion from PPO. Robert is
a past chairman of the Ohio Certified Professional Photog-
raphers Commission and a past president of PPO.

Debora Woodward—Deb is an award-winning photogra-
pher and studio owner from North Webster, Indiana. She
opened her studio, Swan Shores, in 2004, after two decades
of developing her skills as a photographer. Her passion is pho-
tographic artistry. She specializes in senior portraiture, wed-
dings, and nature photography. She is a member of the
Goshen Photographers Guild and of Professional Photog-
raphers of Indiana. Though new to the field of professional
photography, Deb shoots 100 percent digitally, providing
exciting artistic options to her quickly growing client base.

Anthony Zimcosky—Anthony (Tony) Zimcosky is a
native of Cleveland, Ohio, who has worked at Rice Photog-
raphy for over seventeen years. His work has won numerous
awards in print competitions.

Monte Zucker—Monte is a world-famous photographer
who has received every award the industry offers. In 2003,
the United Nations honored him as Portrait Photographer of
the Year. He has also received WPPI’s Lifetime Achievement
Award. He feels that his most special honor is the fact that 
his popularity with photographers of all ages is continually
growing.
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A
Aperture, 46, 56

B
Bakker’s Saddle, 92
Barebulb flash, 72–73
Barndoors, 74
Bayer filter, 24

C
Cameras, digital, 19–30, 57–59

batteries, 30
Bayer filter, 24
burst rate, 21
CCD image sensor, 21–23
CMOS image sensor, 21–23
file formats, 25–26, 27
flash photography, 29–30
ISO settings, 26–28
LCD, 28
megapixels, 19
resolution, 19
shutter lag, 21
storage media, 23–25
viewfinder, 28
white balance, 57–59

Cameras, film, 14–18
medium format, 17–18
point & shoot, 14–15
SLR, 14–15
view cameras, 15–16

Card readers, 25
Catchlights, 79

Close-up photography, 35–37
Color temperature, 9, 51
CompactFlash cards, 23–25
Composition, 89–95

Bakker’s Saddle, 92
centering, 92
center of interest, 89
contrast, 89–90
distracting elements, 92–93
gaze, direction of, 92
horizons, crooked, 93
horizontal lines, dividing, 94–95
improving, 95
leading lines, 90
Rule of Thirds, 91
subject placement, 90–92
vertical lines, crooked, 93–94

Contrast control, 76–78, 89–90
composition and, 89–90
editing, 77–78
light ratios, 78
printing, 77
shooting, 77

Cookies, 76
Cropping, 95

D
Digital cameras, see Cameras, digital
Digital imaging, see Photoshop 

techniques

E
Exposure, 45–59, 76–78

aperture, 46
aperture priority, 56
automatic, 54–56
bracketing, 51
compensation, 51–52
contrast, 76–78
evaluating, 52–54
full program, 54–56
histograms, 53–54
ISO, 57
LCD screen, 52
light ratios, 78
manual, 54
medium, exposing for proper, 51
metering, see Meters
modes, 54
overexposure indicator, 52–53
shutter priority, 56
shutter speed, 46–48
white balance, 57–59

F
File formats, 25–26, 27

JPEG, 26, 27
RAW, 26, 27
TIFF, 25–26

Film, 7–18
35mm, 8
anti-halation, 10
black & white, 8–10
cameras, see Cameras, film
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(Film, cont’d)
color balance, 7–8
digital images from, 14
ISO, 10–11
medium format, 17–18
negative vs. positive, 7
processing, 12–14
reciprocity, 11
storage, 11–12

Filters, 35–37, 83–88, 105
close-up, 35–37, 87–88
color compensating, 85
color conversion, 85
diffusion, 87
digital, 88, 105
filter factors, 84
gelatin, 83
glass, 83–84
infrared, 85–87
neutral density, 87
polarizing, 87
polyester, 83
resin, 83
skylight, 85
types,  84
UV, 85

Flash photography, 29–30, 67–69
accessory flash, 69
built-in flash, 68

Focusing, 40–43
automatic, 43
manual, 41–43
selective, 41

G
Gels, 76
Gobos, 76

H
Handholding, 35
Histograms, 53–54

I
Image capture, 7–30
ISO, 10–11, 26–28, 57

L
Lens care, 44
Lens flare, 43–44
Lenses, 31–44, 87–88

aperture, maximum, 34–35
bellows, 37
close-up photography, 35–37, 

87–88
extension tubes, 37
fisheye, 38
focal length, 31–34
Lensbaby, 40
macro, 36
normal lenses, 31
perspective, 33
perspective control (PC), 38–40
shift, 38–40
teleconverters, 35–36
telephoto lenses, 32–33
wide-angle lenses, 32

Light modifiers, 72–76
barebulb flash, 72–73
barndoors, 74
cookies, 76
gels, 76
gobos, 76
parabolic reflectors, 73
reflectors, 76
softboxes, 74–75
umbrellas, 75

Light, physics of, 60–62
absorption, 62
behavior, 61–62
reflection, 61–62
refraction, 61
spectrum, 61
transmission, 61
types of, 61

Lighting, photographic, 29–30, 
62–82

back lighting, 63
characteristics of, 61–65
direction, 62–64
flash photography, 29–30, 67–69
front lighting, 63

(Lighting, photographic, cont’d)
golden hour, 67
hard vs. soft, 64–66
natural, 66–67
overhead, 66–67
portraiture, see Portrait 

photography
rim lighting, 63
side lighting, 63
size of source, 64–66
studio, see Studio lighting
window, 67

M
Meters, 48–51

color temperature, 51
EV readings, 50
flash, 50
incident light, 49
reflected light, 48–49
spot, 49

Microdrives, 23–25

P
Panning, 48
Parabolic reflectors, 73
Photographic exams and 

certification, 118–21
Photoshop techniques, 102–13

actions, 111–13
artistic filter effects, 105
black & white photos, 105–7
color correction, 102–4
handcoloring, 107–9
retouching, 104–5
toning, 109–111

Portrait photography, 78–82, 92
background light, 79
broad lighting, 79–80
butterfly lighting, 80–81
catchlights, 79
fill light, 79
flat lighting, 80
gaze, direction of, 92
hair light, 79
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(Portrait photography, cont’d)
kicker light, 79
loop lighting, 81
main light, 79
posing, see Posing
profile lighting, 82
Rembrandt lighting, 81
short lighting, 80
split lighting, 81

Posing, 96–101
chin height, 98
feet, 99
full-length poses, 100
group portraits, 100–101
hands, 98
head and shoulders, 96
head tilt, 98
profile view, 97–98
seven-eighths facial view, 97
subject comfort, 96
three-quarter poses, 99–100
three-quarters facial view, 97

Printing, 115–117
dye-sublimation printers, 117
inkjet printers, 117
lab vs. in-house. 115–16

Proofing, 114–15
paper proofs, 114–15
slideshows, 114

R
Reciprocity, 11
Reflectors, 76
Retouching, 95, 102–13
Rule of Thirds, 91

S
Shutter speed, 46–48, 56
Softboxes, 74–75
Studio lighting, 69–82

continuous, 71–72
fluorescent, 72
HMI, 72
light ratios, 78
modeling light, 71
monolights, 70
power packs, 70
strobes, 70–71
tungsten, 72

U
Umbrellas, 75

W
Wallace ExpoDisc, 58
White balance, 57–59

automatic, 57
cloudy day, 58
color temperature setting, 59
custom, 58–59
flash, 58
Kelvin setting, 59
shade, 58
sunny day, 58
tungsten, 58

Workflow, digital, 113–17
color management, 115
image storage, 113–14
printing, 115–117
proofing, 114–15
retouching, 115
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